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ΕΙΣΑΓΩΓΗ 

Τα CMS εργαλεία βοήθησαν στην ανάπτυξη ιστοσελίδων διευκολύνοντας 

έτσι τους χρήστες να αναπαριστούν την πληροφορία στο διαδίκτυο. Ακόμα και 

χρήστες οι οποίοι δεν γνωρίζουν προγραμματισμό ή αρχάριοι προγραμματιστές 

μπορούν να δημιουργήσουν μια ιστοσελίδα με τη χρήση CMS. Το WordPress, για 

παράδειγμα είναι ένα CMS εργαλείο και οι χρήστες μπορούν να επεξεργαστούν 

στοιχεία του γραφικού περιβάλλοντος, να αλλάξουν πρότυπα χωρίς να 

επεξεργαστούν κώδικα. Για να επιτύχουν τροποποιήσεις μπορούν να 

επεξεργαστούν κώδικα HTML και PHP. Το Moodle αποτελεί μία πλατφόρμα 

elearning που υποστηρίζει plugins, templates και μας δίνει τη δυνατότητα να 

επιτύχουμε τους στόχους αυτής της πτυχιακής εργασίας πολύ γρήγορα και με 

μεγαλύτερη ακρίβεια και συνέπεια προς το επιθυμητό αποτέλεσμα. Για το 

θεωρητικό μέρος θα αναλυθούν τα επόμενα κεφάλαια: 

• 1ο  Κεφάλαιο: Σχεδίαση της εφαρμογής. Στο πρώτο κεφάλαιο θα 

αναφερθούν οι απαιτήσεις της εφαρμογής, οι τεχνολογίες και τα εργαλεία τα οποία 

χρησιμοποιήθηκαν για την υλοποίησή της. Γίνεται και μία σύντομη αναφορά στις 

τεχνολογίες τις οποίες απαιτούνται για τη λειτουργία ενός CMS εργαλείου. 

• 2ο Κεφάλαιο: Moodle. Στο δεύτερο κεφάλαιο γίνεται εκτενής αναφορά στην 

πλατφόρμα του Moodle. Αφού δοθούν κάποιες πληροφορίες για το τι είναι το 

Moodle και τι εξυπηρετεί, δίνονται ιστορικά στοιχεία και παρουσιάζονται τα οφέλη 

που προκύπτουν, από τη χρήση του για την ηλεκτρονική μάθηση. 

• 3ο Κεφάλαιο: Εγκατάσταση του Moodle. Στο τρίτο κεφάλαιο αρχικά 

παρουσιάζονται οι απαιτήσεις για την εγκατάσταση του Moodle σε λειτουργικό 

σύστημα Linux. Για να γίνει η εγκατάστασή του πρέπει να προηγηθεί η 

εγκατάσταση όλων των τεχνολογιών που έχουν αναφερθεί στο 1ο κεφάλαιο 

καθώς και οι ρυθμίσεις που πρέπει να γίνουν, δηλαδή του LAMP platform όπως 

χαρακτηριστικά αναφέρεται. Στο τέλος του κεφαλαίου γίνεται αναφορά στη 

διαχείριση ενός Moodle site. 

• 4ο Κεφάλαιο: Στο τέταρτο κεφάλαιο γίνεται λεπτομερής αναφορά στα 

Courses (μαθήματα) του Moodle. Παρατίθενται οι ρόλοι των συμμετεχόντων σε 

ένα course καθώς οι πόροι και οι δραστηριότητες που μπορεί να περιλαμβάνει. 

Στη συνέχει δίνονται αναλυτικές οδηγίες για τη δημιουργία, διαγραφή και 

διαχείριση ενός course με κάθε λεπτομέρεια. Γίνεται αναφορά στις κατηγορίες των 

μαθημάτων και πως αυτές μπορούν να δημιουργηθούν. Επίσης αναλύονται τα 

format των courses και δίνονται αναλυτικές οδηγίες για τις ρυθμίσεις κατά τη 

δημιουργία ενός course. 
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• 5ο Κεφάλαιο: Groups. Στο πέμπτο κεφάλαιο γίνεται λεπτομερής ανάλυση 

για τις ομαδοποιήσεις των συμμετεχόντων στα courses του Moodle, τα λεγόμενα 

groups. Δίνονται αναλυτικές οδηγίες για τη δημιουργία τους και για τις ρυθμίσεις 

που μπορεί να κάνει ο διαχειριστής ενός μαθήματος. 

• 6ο  κεφάλαιο: στο έκτο κεφάλαιο γίνεται αναφορά στο Forum module. 

Αναλύεται αρχικά ο τρόπος λειτουργίας ενός forum. Έπειτα αναφέρονται 

παραστατικά οι ρυθμίσεις που πρέπει να γίνουν καθώς και οι τύποι του forum που 

μπορούν να χρησιμοποιηθούν και σε ποιες περιπτώσεις. Δίνονται οδηγίες για τη 

δημιουργία ρόλου επισκέπτη, guest access όπως αναφέρεται στο Moodle, και τα 

δικαιώματα που έχει για τη χρήση του forum. Τέλος παρουσιάζονται οι επιλογές 

για την αποδοτικότερη χρήση ενός forum καθώς και για το διαμοιρασμό αρχείων 

και τη διαχείριση των συζητήσεων σε αυτό. 

• 7ο κεφάλαιο: Database activity module. Στο έβδομο κεφάλαιο γίνεται 

αναφορά στις βάσεις δεδομένων για το Moodle. Αρχικά δίνονται οι οδηγίες και οι 

ρυθμίσεις για τη δημιουργία βάσης δεδομένων. Έπειτα γίνεται αναφορά στα πεδία 

και στους τύπους που μπορεί να περιέχει μία βάση. Τέλος γίνεται εκτενής και 

λεπτομερής ανάλυση για τα templates που αποτελούν βασικό στοιχείο για μια 

βάση δεδομένων στο Moodle. 

• 8ο κεφάλαιο: Portal. Στο 8ο και τελευταίο κεφάλαιο παρουσιάζεται η 

δημιουργία του Portal μέσα από αναλυτικές οδηγίες και εικόνες. Παρουσιάζεται 

αρχικά η δημιουργία ενός course και των group που αυτό περιλαμβάνει, η 

δημιουργία forum και βάσης δεδομένων. 
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ΠΕΡΙΛΗΨΗ 

Η παρούσα εργασία με θέμα «Δημιουργία portal με χρήση του Moodle», 

έχει ως στόχο την ανάπτυξη ενός portal με δυνατότητες registration και login 

χρησιμοποιώντας το Moodle ως εργαλείο ανάπτυξης. Επίσης μέσα στο portal 

υπάρχει η δυνατότητα δημιουργίας και διαχείρισης ανεξάρτητων ομάδων καθώς 

και forum ανά ομάδα. Επιπλέον υπάρχει και ειδική λειτουργία για Upload 

εγγράφων διαφόρων τύπων τα οποία καταγράφονται σε βάση δεδομένων. 
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ABSTRACT 

The project with the title "Portal Creation with the use Moodle" aims to the 

progress of a portal with potentials of registration and login by using the Moodle. 

Also within the portal you can create and administer independent groups and 

forums per group. Moreover there is a special function of uploading various types 

of documents that are saved and put into a database. 
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ΚΕΦΑΛΑΙΟ 1 

Σχεδίαση της εφαρμογής   
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ΕΙΣΑΓΩΓΗ 

Στο κεφάλαιο αυτό θα αναφερθούν τα εργαλεία και οι τεχνολογίες που 

χρησιμοποιήθηκαν για την δημιουργία του Portal. Αναφέρονται λεπτομέρειες για 

τις τεχνολογίες των MySQL, Apache server, CMS, PHP. 

1.1 Στόχοι-Απαιτήσεις της εφαρμογής 

Ο κύριος στόχος της εφαρμογής είναι η δημιουργία portal στην οποία οι 

χρήστες θα μπορούν κάνουν registration και login χρησιμοποιώντας το Moodle ως 

εργαλείο. Για να μπορέσει ο χρήστης να χρησιμοποιήσει το Moodle, αλλά και 

οποιοδήποτε CMS εργαλείο, θα πρέπει να εγκαταστήσει, στο εκάστοτε λειτουργικό 

σύστημα που χρησιμοποιεί, μια σειρά από τεχνολογίες. Εκτός από τις κλασσικές 

λειτουργίες το συγκεκριμένο portal θα πρέπει να υποστηρίζει και κάποιες επιπλέον 

όπως: 

• Δημιουργία ανεξάρτητων ομάδων και διαχείριση αυτών. 

• Η δημιουργία forum θα πρέπει να υποστηρίζει ομάδες. 

• Λειτουργία Upload εγγράφων διαφόρων τύπων και καταγραφή τους στη 

βάση δεδομένων. 

• Αναζήτηση των εγγράφων με κριτήρια. 

1.2 MySQL 

Η MySQL είναι ένα σύστημα διαχείρισης σχεσιακών βάσεων δεδομένων 

που τρέχει σε έναν server παρέχοντας πρόσβαση πολλών χρηστών σε ένα 

σύνολο βάσεων δεδομένων. Επίσης αποτελεί μια δημοφιλή βάση δεδομένων για 

διαδικτυακά προγράμματα και ιστοσελίδες. Χρησιμοποιείται από τις πιο 

διαδεδομένες διαδικτυακές υπηρεσίες όπως το Flickr, το YouTube, το Google, το 

Facebook και το Twitter. Μερικά από τα πλεονεκτήματά της είναι: 

• Είναι αρκετά σταθερή που σημαίνει ότι δεν είναι επιρρεπής σε αποτυχίες 

και λάθη ακόμα και με μεγάλο φόρτο. 

• Διατίθεται δωρεάν. 

• Δεν έχει μεγάλες απαιτήσεις συστήματος. 

• Είναι εύκολη και γρήγορη στη χρήση της. 

1.3 PHP 

H PHP είναι μια server-side scripting γλώσσα. Το ότι ορίζεται ως serverside 

γλώσσα σημαίνει ότι τα αρχεία php εκτελούνται στον server και όχι στον 

υπολογιστή του χρήστη. Μια σελίδα PHP περνά από επεξεργασία από συμβατό 

web server, APACHE για παράδειγμα, ώστε να παραχθεί σε πραγματικό χρόνο το 

τελικό περιεχόμενο που θα σταλεί στο πρόγραμμα περιήγησης των επισκεπτών σε 

μορφή κώδικα HTML. Ένα αρχείο με κώδικα PHP θα πρέπει να έχει και την 
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κατάλληλη επέκταση (π.χ *.php, *.php4, *.phtml κ.ά). Όταν ένα αρχείο έχει την 

επέκταση .php, θα πρέπει ο server να είναι ρυθμισμένος για να επεξεργάζεται 

κώδικα PHP. Η PHP χρησιμοποιήθηκε για την ανάπτυξη του Moodle. Ο web 

server εντοπίζει τις PHP σελίδες, καθώς και τις επεκτάσεις τους, και τις στέλνει 

στην PHP για εκτέλεση. Για να λειτουργήσει σωστά το Moodle πρέπει να 

εγκατασταθεί και να λειτουργήσει σωστά και η PHP. 

1.4 Apache 

Eίναι ένας web server. Κάθε φορά που ένας χρήστης επισκέπτεται μια 

ιστοσελίδα ο browser επικοινωνεί με έναν server μέσω του πρωτοκόλλου HTTP, ο 

οποίος παράγει τις ιστοσελίδες και τις αποστέλλει στον browser. Ο Apache είναι 

ένας από τους δημοφιλέστερους web servers και λειτουργεί σε διάφορες 

πλατφόρμες όπως Windows, Linux, Unix, Mac OS X. Αποτελεί open source 

λογισμικό και συντηρείτε από μία κοινότητα ανοιχτού κώδικα από το Apache 

Software Foundation. 

Ο Apache διαθέτει ποικιλία χαρακτηριστικών και μπορεί να υποστηρίξει μια 

μεγάλη γκάμα εφαρμογών με τις οποίες και συνεργάζεται. Οι δυνατότητες του 

προγράμματος αυτού καθαυτού και τα χαρακτηριστικά του δεν είναι και τόσο πολλά. 

Ένα από τα βασικότερα χαρακτηριστικά του όμως, το οποίο και του δίνει μεγάλες 

δυνατότητες, είναι ότι μπορεί να προσαρμόσει επάνω του πολλές προσθήκες 

προγραμμάτων (modules), τα οποία με τη σειρά τους παρέχουν διαφορετικές 

λειτουργίες. Μερικά από τα πιο γνωστά modules του Apache HTTP είναι τα 

modules πιστοποίησης, όπως για παράδειγμα τα mod_access, mod_auth, 

mod_digest κτλ. Παρέχει επίσης SSL σε TLS μέσω των (mod_ssl), και proxy 

module (mod_proxy), πραγματοποιεί ανακατευθύνσεις διευθύνσεων (URL rewrites) 

μέσω του mod_rewrite, καταγραφές συνδέσεων μέσω του mod_log_config, 

συμπίεση αρχείων μέσω του mod_gzip και πολλά άλλα modules τα οποία 

διατίθενται είτε απ’ο το Apache Software Foundation, είτε από τρίτες εταιρίες 

λογισμικού. Ο Apache HTTP υποστηρίζει επίσης αρκετές διάσημες εφαρμογές και 

γλώσσες προγραμματισμού όπως MySQL, PHP, Perl, Python κλπ. Αυτά είναι 

μερικά από τα χαρακτηριστικά και τις λειτουργίες του που κάνουν τον Apache τον 

πιο δημοφιλή Web Server από το 1996 έως τις μέρες μας. Περισσότερο από το 

50% των ιστοχώρων του παγκόσμιου ιστού, χρησιμοποιεί τον Apache ως 

εξυπηρετητή. Το υπόλοιπο ποσοστό καλύπτουν αντίστοιχα προγράμματα, όπως 

το Microsoft Internet Information Services (IIS), ο Sun Java System Web Server, ο 

Zeus Web Server κα. 
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1.5 Τι είναι CMS 

Ο όρος Συστήματα Διαχείρισης Περιεχομένου (Content Management 

Systems ή CMS), αναφέρεται στις εφαρμογές που επιτρέπουν τη δημιουργία, 

διαχείριση, διανομή, δημοσίευση και τον εντοπισμό της πληροφορίας, τη 

δυνατότητα να διαχειριστείτε τη δομή του site σας, την εμφάνιση των 

δημοσιευμένων σελίδων και την πλοήγηση που προσφέρεται στους επισκέπτες 

και χρήστες της. Ο όρος CMS χρησιμοποιείται γενικότερα για τέτοιου είδους 

συστήματα λογισμικού. Όταν ένα σύστημα χρησιμοποιείται για διαχείριση 

περιεχομένου στο διαδίκτυο ονομάζεται Web CMS (WCMS). Μερικές από τις 

επιλογές/λειτουργίες που μας προσφέρει ένα WCMS είναι οι εξής: 

• Διαχείριση των δεδομένων χωρίς να γνωρίζουμε αναγκαστικά HTML, PHP 

κ.ά. 

• Επέκταση του site χρησιμοποιώντας components, plugins, templates. 

• Διαχείριση των χρηστών του site με επιλογές για διαφορετικές ομάδες 

χρηστών με διαφορετικά δικαιώματα πρόσβασης κ.ά. 

• Επιτρέπει τη διαχείριση της δομής του site 

• Ανάρτηση και δημοσίευση άρθρων χωρίς κανένα περιορισμό στον αριθμό 

τους ή στο μέγεθός τους. 

• Δυνατότητα προβολής διαφημίσεων με κείμενο ή banners. 

• Δυνατότητα κατασκευής πολυγλωσσικής ιστοσελίδας (Multilanguage) 

• Δυνατότητα λήψης αντιγράφου ασφαλείας του site (back up). 
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ΕΠΙΛΟΓΟΣ 

Τα CMS εργαλεία είναι εφαρμογές ανοιχτές προς το κοινό που μας δίνουν τη 

δυνατότητα να δημιουργήσουμε δικές μας επεκτάσεις που καλύπτουν τις ανάγκες 

μας ενσωματώνοντάς τες στο Σύστημα Διαχείρισης. Σε αυτό το κεφάλαιο αναλύσαμε 

εν συντομία τις τεχνολογίες που χρησιμοποιήθηκαν για τη δημιουργία του portal.   
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ΚΕΦΑΛΑΙΟ 2 

Moodle  
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ΕΙΣΑΓΩΓΗ 

Το Moodle – Modular Object Oriented Learning Environment, είναι ένα 

πακέτο λογισμικού για τη διεξαγωγή ηλεκτρονικών μαθημάτων μέσω Διαδικτύου 

που προσφέρει ολοκληρωμένες υπηρεσίες Ασύγχρονης τηλεκπαίδευσης. 

Χαρακτηρίζεται και ως λογισμικό διαχείρισης μαθημάτων – Course Management 

System ή ως ένα σύστημα εικονικής μάθησης – Virtual Learning Environment. 

Αποτελεί open source λογισμικό (κάτω από την GNU Public License), διατίθεται 

δωρεάν, και μπορεί να τρέξει σε οποιοδήποτε σύστημα υποστηρίζει PHP, ενώ έχει 

τη δυνατότητα να συνδυάζεται με πολλούς τύπους βάσεων δεδομένων, ιδιαίτερα 

με MySQL. 

Η καινοτομία του Moodle βασίζεται στο ότι τα εργαλεία που περιέχει 

προσανατολίζουν τη διαδικασία της μάθησης σε τέσσερις άξονες: 

1) Την ποικίλη προσέγγιση του εκπαιδευτικού υλικού μέσα από διάφορες 

γλώσσες επικοινωνίας, όπως κείμενα, εικόνες, πολυμέσα, και τον 

προσανατολισμό της διδασκαλίας στην δημιουργία περιεχομένου. 

2) Την ενεργή στάση του μαθητή απέναντι στο υλικό, την αυτοδιδασκαλία και τη 

μαθησιακή του αυτονόμηση. 

3) Την ανάπτυξη της κριτικής σκέψης. 

4) Την ανάπτυξη της συνεργατικότητας και της ευελιξίας στην ανάπτυξη 

ποικίλλων ρόλων στο πλαίσιο μιας ερευνητικής ομάδας. 

Έτσι η τάξη μετατρέπεται σε εργαστήριο και ο μαθητής, ασκούμενος στην 

επικοινωνία σε μια πληθώρα γλωσσών αποκτά ολοένα περισσότερες ικανότητες 

ερμηνείας και αναπαράστασης του κόσμου. Η γνώση που αποκτάται με αυτό τον 

τρόπο δεν είναι στείρα πληροφορία. Ο δάσκαλος σαν εγγυητής της επάρκειας των 

εκπαιδευτικών πόρων, φροντίζει για την πολλαπλή - μέσω Moodle – ανανέωση 

αυτής της αναπαράστασης αναδιατάσσοντας το υλικό και εμπλουτίζοντάς το με 

διαφορετικές γλώσσες. Οι μαθητές, από την μεριά τους, επεμβαίνουν στο 

εκπαιδευτικό υλικό και δημιουργώντας νέο περιεχόμενο, το οικειοποιούνται, 

χτίζοντας σταδιακά την δική τους εικόνα του κόσμου. 

Η δεύτερη καινοτομία είναι θεσμική: από κατασκευή του το Moodle επιβάλλει 

στους χρήστες την ανάληψη ρόλων στο πλαίσιο των μαθημάτων. Κάθε χρήστης 

αναλαμβάνει κάποιον ρόλο στα μαθήματα ή ενότητες που είναι εγγεγραμμένος. Οι 

ρόλοι - και μαζί τα προνόμια που τους συνοδεύουν - εναλλάσσονται στον βαθμό 

που ο μαθητής-χρήστης δημιουργώντας περιεχόμενο αναβαθμίζεται στο πλαίσιο 

του συστήματος. Αν το Moodle εισέλθει πετυχημένα στην τάξη, η εικονική 

ανάληψη διαφορετικών ρόλων συνοδεύεται από μια ανάλογη εναλλαγή ρόλων 

στην πραγματικότητα. Με αυτόν τον τρόπο , ο απλός εγγεγραμμένος μαθητής 

μπορεί να αναβαθμισθεί σε δημιουργό μαθήματος, ή υπεύθυνο για την διδασκαλία 
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μιας ενότητας, ενώ ο δάσκαλος μπορεί να είναι διαχειριστής ή και μαθητής στο ίδιο 

αυτό μάθημα. 

Η τρίτη καινοτομία αφορά την δικτύωση. Οι μαθητές και ο δάσκαλος χωρίζονται 

συγκυριακά σε ομάδες, ανταλλάσσουν μέσα από την πλατφόρμα μηνύματα, 

μοιράζονται πόρους, ή -ακόμη- συνδιαμορφώνουν περιεχόμενο μέσα από τα 

ενσωματωμένα wikis του Moodle. Στην συνέχεια, καλούν άλλες τάξεις του 

σχολείου τους (ή και άλλου σχολείου) να μοιραστούν την εργασία τους και να 

συμμετάσχουν στην έρευνά τους. Το σχολείο εκμεταλλεύεται αυτά τα δίκτυα για να 

έρθει σε επαφή με άλλα σχολεία και να συνεργασθεί μαζί τους. 

2.1 Γενικά για το Moodle 

Το Moodle δημιουργήθηκε από τη Moodle Project, η οποία καθοδηγείται και 

συντονίζεται από μία εταιρία 30 προγραμματιστών, τη Moodle HQ, που 

υποστηρίζεται οικονομικά από ένα δίκτυο 60 εταιριών παγκοσμίως. Το Moodle το 

εμπιστεύονται και το χρησιμοποιούν μικροί και μεγάλοι οργανισμοί, ινστιτούτα και 

πανεπιστήμια όπως το London School of Economics, State University of New York, 

Microsoft and the Open University. Αριθμεί περισσότερους από 60 εκατομμύρια 

χρήστες τόσο σε επιχειρηματικό όσο και σε ακαδημαϊκό επίπεδο γεγονός που το 

καθιστά την πιο διαδεδομένη πλατφόρμα e-learning. 

Σχεδιάστηκε τόσο για την υποστήριξη της διδασκαλίας όσο και της μάθησης. 

Με περισσότερα από 10 χρόνια ανάπτυξης με την κονστρουκτιβιστική θεωρία της 

μάθησης παρέχει ισχυρά εργαλεία καθώς και συνεργασιακό περιβάλλον μάθησης 

προς τους χρήστες που ενισχύουν τόσο τη διδασκαλία όσο και τη μάθηση. 

Παρέχει ένα απλό και εύχρηστο interface, drag and drop δυνατότητες και 

ένα πολύ καλό και δομημένο documentation. Σε συνδυασμό με τη διαρκή 

βελτίωση της χρηστικότητάς του το Moodle αποτελεί ένα ευκολόχρηστο εργαλείο. 

2.2 Υποστήριξη γλωσσών 

Η πλατφόρμα του Moodle παρέχεται σε περισσότερες από 120 

διαφορετικές γλώσσες, παρέχοντας έτσι τη δυνατότητα σε χρήστες διαφορετικών 

χωρών να χρησιμοποιούν τους πόρους και τις δυνατότητές της στο έπακρο. 

Επίσης παρέχεται και το Moodle community forums που δίνει τη δυνατότητα στους 

χρήστες διαφορετικών εθνικοτήτων και χωρών να συζητούν και να ανταλλάσσουν 

απόψεις και προβληματισμούς και να συνομιλούν με χρήστες στις προτεινόμενες 

γλώσσες. 

2.3 All-in-one e-learning platform 

Επίσης παρέχει τη δυνατότητα του All-in-one learning platform δηλαδή 

ενεργοποιώντας και απενεργοποιώντας διάφορα βασικά χαρακτηριστικά δίνεται η 

ευκαιρία στους χρήστες να χρησιμοποιούν τα online courses αλλά και τα forums, 

wikis, chats και blogs. 
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2.4 Ευελιξία και παραμετροποίηση 

Όπως έχει προαναφερθεί είναι open-source πλατφόρμα, ο χρήστης μπορεί 

να προσαρμόσει το Moodle σύμφωνα με τις εκάστοτε ανάγκες του. Ο τρόπος με 

τον οποίο έχει σχεδιαστεί επιτρέπει στους προγραμματιστές να δημιουργήσουν 

plugins και να ενσωματώσουν add-ons (εξωτερικές εφαρμογές) για την επίτευξη 

διάφορων στόχων τους. Λόγω της ευελιξίας και της επεκτασιμότητας που παρέχει 

μπορεί να υποστηρίξει από μια μικρή ομάδα χρηστών μέχρι και ομάδες που 

αριθμούν χιλιάδες χρηστών. Για αυτούς τους λόγους τυγχάνει ευρείας 

χρησιμότητας σε μεγάλο μέρος της εκπαιδευτικής κοινότητας, κυβερνήσεων, μη 

κερδοσκοπικών επιχειρήσεων και διάφορων οργανισμών. 

2.5 Ασφάλεια και ιδιωτικότητα 

Όσον αφορά την ασφάλεια και την ιδιωτικότητα εγγυάται την προστασία και 

ακεραιότητα των δεδομένων καθώς και την ιδιωτικότητα των χρηστών . Μπορεί 

πολύ εύκολα να προσαρμοστεί και να λειτουργήσει σε private secure cloud ή και σε 

server. 

ΕΠΙΛΟΓΟΣ 

Το Moodle είναι μια πλατφότμα e-learning που χρησιμοποείται ευρέως από 

εταιρίες και οργανισμούς για ασύγρονη εκπαίδευση. Οι χρήστες του μπορούν να 

προσεγγίσουν το υλικό με διάφορους τρόπους όπως κείμενα, εικόνες, πολυμέσα 

και μπορούν να αναπτύξουν τη συνεργατικότητα αναλαμβάνοντας ρόλους στο 

πλαίσιο μαθημάτων. Υποστηρίζει πληθώρα διαφορετικών γλωσσών και παρέχει τη 

δυνατότητα του All-in-one learning. Οι χρήστες του Moodle μπορούν να το 

προσαρμόσουν ανάλογα με τις ανάγκες τους και για να πετύχουν διάφορους 

στόχους μπορούν να αναπτύξουν plugins και add-ons πέρα από αυτά που 

προσφέρει το λογισμικό του. 
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ΚΕΦΑΛΑΙΟ 3 

Εγκατάσταση του Moodle  
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ΕΙΣΑΓΩΓΗ 

Το Moodle αναπτύχθηκε για να τρέχει κυρίως σε Linux χρησιμοποιώντας 

Apache, PostgreSQL/MySQL/MariaDB και PHP, ή καλύτερα αναφέρεται ως LAMP 

platform. Αναμφίβολα αποτελεί τον καλύτερο και ασφαλέστερο, και τον πιο 

συνηθισμένο, συνδυασμό λειτουργίας για το Moodle. Εναλλακτικά μπορεί να γίνει 

και εγκατάσταση σε Windows Server σε συνδυασμό με PHP 5.5 και Visual C++ 

Redistributable for Visual Studio 2012. 

Απαιτήσεις συστήματος 

• Χωριτικότητα δίσκου: 160MB (ελάχιστο) ελεύθερος χώρος συν όσο 

χρειάζεστε για την αποθήκευση των υλικών. 5GB είναι πιθανόν ρεαλιστικό. 

• Επεργαστής: 1GHz (ελάχιστο), συνιστάται 2GHz dual core. 

• Μνήμη: 256MB (ελάχιστο), συνήθως συνιστάται 1GB ή και περισσότερο. Ο 

γενικός κανόνας ορίζει ότι το Moodle μπορεί να υποστηρίξει 10 με 20 

χρήστες ταυτόχρονα για κάθε 1GB μνήμης RAM, αλλά αυτό ποικίλλει 

ανάλογα με το συνδυασμό υλικού και λογισμικού και το είδος της χρήσης. 

“Ταυτόχρονα” σημαίνει ότι εκτελούνται πραγματικές διεργασίες web server 

κατά το ίδιο χρονικό διάστημα και όχι συνδεδεμένοι χρήστες. 

3.1 Ρυθμίσεις για τον server 

Κατεβάστε και αντιγράψτε τα αρχεία (έχετε 2 επιλογές): 

 Κατεβάστε τις απαιτούμενες εκδόσεις από το http://moodle.org/downloads 

και αποσυμπιέστε. 

 Αντιγράψτε τον κώδικα από το Git repository (συνιστάται για 

προγραμματιστές και καθιστά την αναβάθμιση πολύ απλή): 

$ git cline –depth1=1 – b MOODLE_27_STABLE –single- 

branch git://git.moodle.org/moodle.git --depth=1. 

Στη συνέχεια δημιουργούμε ένα φάκελο με όνομα “moodle” που θα περιέχει 

τα αρχεία και τους φακέλους του Moodle. Στην περίπτωση που τοποθετήσουμε το 

φάκελο στο web server τότε η προσπέλαση του Moodle που δημιουργήσαμε θα 

γίνεται ως εξής: http://yourwebserver.com/moodle. Αλλιώς αν γίνει αντιγραφή 

ολόκληρου του καταλόγου στο web server τότε θα γίνεται: 

http://yourwebserver.com. 

Στα αρχεία έχουν πρόσβαση μόνο ο administrator/superuser. Μπορούν όμως να 

τα διαβάσουν όλοι (readable). 

 Secure the Moodle files: είναι σημαντικό να αναφερθεί ότι τα αρχεία δεν 

είναι εγγράψιμα (writable). Για παράδειγμα, σε Linux/Unix (as root): 

# chown -R root /path/to/moodle 

# chmod -R 0755 /path/to/moodle 
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# find /path/to/moodle -type f -exec chmod 0644 {} \; 

Αν θέλετε να χρησιμοποιήσετε το built-in plugin installer θα πρέπει να 

δημιουργηθεί ένα φάκελος από τον χρήστη. Συνιστάται να χρησιμοποιήσετε το 

ACL εφ’ όσον το υποστηρίζει ο server, για παράδειγμα αν ο Apache server 

χρησιμοποιεί account www-data: 

# chmod -R +a "www-data allow 

read,delete,write,append,file_inherit,directory_inherit" 

/path/to/moodle 

3.2 Δημιουργία Βάσης Δεδομένων 

Στη συνέχεια θα πρέπει να δημιουργήσετε μία νέα βάση δεδομένων και να 

σημειωθούν τα εξής στοιχεία για την είσοδο στην πλατφόρμα: 

• dbhost – όνομα για τον server της βάσης δεδομένων 

• dbname – όνομα βάσης δεδομένων 

• dbuser – όνομα χρήστη για τη βάση δεδομένων 

• dbpass – κωδικός πρόσβασης για το χρήστη 

3.3 Δημιουργία φακέλου δεδομένων - data directory 

Το Moodle απαιτεί ένα φάκελο (directory) που θα αποθηκεύονται όλα τα 

αρχεία όπως uploaded files, temporary data, cache, session data κ.ά. Στον web 

server θα πρέπει να υπάρχει ο απαιτούμενος ελεύθερος χώρος. 

Σημείωση: στον παραπάνω φάκελο δεν πρέπει να υπάρχει άμεση πρόσβαση 

από web environment για λόγους ασφαλείας. Επίσης δεν πρέπει να τοποθετηθεί 

στο web root ή στο φάκελο του Moodle διότι δεν θα γίνει η εγκατάσταση. 

Παρακάτω δίνεται ένα παράδειγμα για τη δημιουργία του directory και τα 

δικαιώματα για Unix/Linux. 

# mkdir /path/to/moodledata 

# chmod 0777 /path/to/moodledata 

Αν ο server υποστηρίζει ACL τότε προτείνεται να δοθούν τα παρακάτω 

δικαιώματα, για παράδειγμα αν ο Apache server έχει account www-data: 

# chmod -R +a "www-data allow 

read,delete,write,append,file_inherit,directory_inherit" /path/to/moodledata 

Αν θέλετε να εκτελέσετε PHP scripts από τη γραμμή εντολών θα πρέπει να 

δώσετε τα παρακάτω δικαιώματα στον χρήστη: 

$ sudo chmod -R +a "`whoami` allow 
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read,delete,write,append,file_inherit,directory_inherit" /path/to/moodledata. 

3.3.1 Securing moodledata in a web directory 

Αν η μοναδική σας επιλογή είναι να τοποθετήσετε το ‘moodledata’ στο 

φάκελο για πρόσβαση από το web τότε θα πρέπει να δημιουργήσετε το .htaccess 

file στο ‘moodledata’ φάκελο. Τα παραπάνω δεν λειτουργούν σε όλα τα λειτουργικά 

συστήματα. Δημιουργήστε ένα αρχείο με όνομα .htaccess συμπεριλαμβάνοντας τα 

παρακάτω: 

order deny,allow 

deny from all 

3.4 Ξεκινώντας την εγκατάσταση του Moodle 

Για την εγκατάσταση του Moodle θα πρέπει να δημιουργήσετε τους πίνακες 

της βάσης δεδομένων καθώς και να κάνετε τις απαραίτητες ρυθμίσεις για το site. 

Ο προτεινόμενος τρόπος είναι να χρησιμοποιήσετε το command line installer. Αν 

δεν μπορείτε για οποιοδήποτε λόγο, για παράδειγμα αν χρησιμοποιείτε Windows 

server, είναι διαθέσιμο το web based installer. 

3.5 Command line installer 

Ένα παράδειγμα εγκατάστασης χρησιμοποιώντας command line ως root: 

# chown www-data /path/to/moodle 

# cd /path/to/moodle/admin/cli 

# sudo -u www-data /usr/bin/php install.php 

# chown -R root /path/to/moodle 

Η chown επιτρέπει στο script να εγγράψει ένα νέο config.php αρχείο. 

Περισσότερες πληροφορίες μπορείτε να βρείτε ανατρέχοντας στην εντολή # php 

install.php –help. 

3.6 Web base installer 

Για να εκτελέσετε το web installer script, θα πρέπει απλά να εισάγετε σε 

web browser το URL για το Moodle. Κατά τη διαδικασία εγκατάστασης θα σας 

ζητηθεί να επιβεβαιώσετε τα πνευματικά δικαιώματα, θα δημιουργηθούν οι πίνακες 

της βάσης δεδομένων, θα σας ζητηθεί να δώσετε τα στοιχεία για το λογαριασμό 

του διαχειριστή και για τη διαχείριση του site. Για την δημιουργία της βάσης 

δεδομένων απαιτείται κάποιο χρονικό διάστημα. Τελειώνοντας θα πρέπει να 

βρεθείτε στην αρχική σελίδα του Moodle που θα σας ζητηθεί να δημιουργήσετε 

ένα νέο μάθημα. Είναι πολύ πιθανό να σας ζητηθεί να κατεβάσετε εκ νέου το 
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config.php και να το τοποθετήσετε και πάλι στο Moodle σύμφωνα με τις οδηγίες 

που θα αναφέρονται. 

3.7 Ρυθμίσεις για το Moodle 

Μερικές από τις πιο σημαντικές ρυθμίσεις που πιθανόν θα πρέπει να 

προσέξετε βρίσκονται στο Site Administration tab του Administration block. 

• Administration > Site administration > Plugins > Message outputs > Email: 

ρυθμίσεις για τον SMTP και για το authentication των χρηστών αν αυτό απαιτείται. 

Επίσης μπορεί να γίνουν και οι ρυθμίσεις για το support contact του site. 

• Administration > Site administration > Server > System paths: ρυθμίσεις για 

τα paths du, dot και aspell. 

• Administration > Site administration > Server > HTTP: αν υπάρχει 

ενεργοποιημένο το τοίχος προστασίας θα πρέπει να ρυθμίσετε τον proxy από το 

Web proxy section. 

• Administration > Site administration > Location > Update timezones: 

εκτελώντας το μπορείτε να ελέγξετε αν το timezones είναι ενημερωμένο. 

3.8 LAMP, Linux Apache MySQL PHP 

Η PHP μπορεί να αντικατασταθεί από την Perl ή Python όπως και η MySQL 

με lighttpd. 

Πριν ξεκινήσετε την εγκατάσταση βεβαιωθείτε ότι το λειτουργικό σας σύστημα είναι 

ενημερωμένο. 

# aptitude update && aptitude upgrade 

3.8.1 MySQL 

Εγκαταστήστε τη MySQL χρησιμοποιώντας την παρακάτω εντολή: 

# aptitude install mysql-server mysql-client 
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Μετά την ολοκλήρωση της εγκατάστασης της MySQL πρέπει να αλλάξετε τον 

κωδικό πρόσβασης για τη ρίζα. Αυτό το βήμα δεν είναι απαραίτητο για τη διανομή 

Lenny διότι θα σας ζητηθεί να εισάγεται τον κωδικό πρόσβασης κατά την διάρκεια 

της εγκατάστασης. 

 # /usr/bin/mysqladmin -u root password 'enter-your-good-new-

password-here' 

Θα πρέπει να δημιουργήσετε έναν ξεχωριστό λογαριασμό για να συνδεθείτε 

στη βάση δεδομένων του MySQL, μπορείτε να προσθέσετε χρήστες στη βάση 

αυτή, και να δώσετε δικαιώματα χρήσης χρησιμοποιώντας πίνακα ελέγχου, 

όπως το phpMyAdmin.  

3.8.2 Apache 2 

Για την εγκατάσταση του web server δώστε την παρακάτω εντολή: 

# aptitude install apache2 apache2-doc 

3.8.2.1 Διαμορφώστε τους καταλόγους χρηστών για τον Apache web server 

Ενεργοποήστε τη μονάδα 

# a2enmod userdir 

Ρυθμίσεις για τον Apache στο /etc/apache2/mods-enabled/userdir.conf : 
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<IfModule mod_userdir.c> 

UserDir public_html 

UserDir disabled root 

<Directory /home/*/public_html> 

AllowOverride All 

Options MultiViews Indexes SymLinksIfOwnerMatch 

<Limit GET POST OPTIONS> 

Order allow,deny 

Allow from all 

</Limit> 

<LimitExcept GET POST OPTIONS> 

Order deny,allow 

Deny from all 

</LimitExcept> 

</Directory> 

</IfModule> 

Δημιουργήστε φάκελο ως χρήστης (και όχι ως root): 

$mkdir /home/$USER/public_html 

Αντικαταστήστε το όνομα χρήστη και κάντε επανεκίννηση τον web server: 

# chgrp www-data /home/<username>/public_html 

# service apache2 restart 
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Εάν λάβετε κάποιο σφάλμα κατά την πρόσβαση στο φάκελο μέσω του Apache 

ελέγξτε αν τα δικαιώματα για /home/username είναι drwxr-xr-x. Αν τα δικαιώματα 

δεν είναι ίδια με τα παραπάνω διορθώστε τα όπως παρακάτω: 

# chmod 755 /home/<username> 

Για να λειτούργεί η PHP ελέγξτε αν το /etc/apache2/mods-available/php5.conf 

είναι σωστό: 

<IfModule mod_php5.c> 

<FilesMatch "\.ph(p3?|tml)$"> 

SetHandler application/x-httpd-php 

Require all granted 

</FilesMatch> 

<FilesMatch "\.phps$"> 

SetHandler application/x-httpd-php-source 

Require all denied 

</FilesMatch> 

# To re-enable php in user directories comment the following lines 

# (from <IfModule ...> to </IfModule>.) Do NOT set it to On as it 

# prevents .htaccess files from disabling it. 

#<IfModule mod_userdir.c> 
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 # <Directory /home/*/public_html> 

 # php_admin_value engine Off 

 # </Directory> 

#</IfModule> 

</IfModule> 

 

Προσθέστε κάποιο περιεχόμενο στο ~/public_html και δείτε τα αποτελέσματα στο 

http://localhost/~username.Τοποθετήστε διαδικτυακό περιεχόμενο στο 

~/public_html και δείτε τα αποτελέσματα στο http://localhost/~username. 

3.8.3 The “P” part 

Εγκαταστήστε την PHP εισάγοντας σε κονσόλα την παρακάτω εντολή: (το σύμβολο 

# συμβολίζει τη ρίζα-root): 

# aptitude install php5 php5-mysql libapache2-mod-php5 

Αν προτιμάτε την Perl, τότε δώστε την εντολή: 

 

# aptitude install python libapache2-mod-python 

3.8.4 Διαμόρφωση 

Apache2 configuration file: /etc/apache2/apache2.conf 

Μπορείτε να επεξεργαστείτε το αρχείο αυτό αν είναι απαραίτητο, αλλά στις 

περισσότερες απλές εφαρμογές δεν είναι απαραίτητο διότι χρησιμοποιείται το 

conf.d. 

# aptitude install perl libapache2-mod-perl2 

Αν προτιμάτε την Python , τότε δώστε την εντολή : 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

30 από 132 

3.8.5 Test PHP 

Για να ελέγξετε αν λειτουργεί η PHP, επεξεργαστείτε το αρχείο 

/var/www/apache2default/test.php: 

 

Για να αρχίσετε να το χρησιμοποιείτε στη συνέχεια πληλτρολογήστε στο browser 

http://<SERVERIP>/apache2-default/test.php. 

 

3.8.6 phpMyAdmin 

Για την εγκατάσταση της phpMyAdmin: 

# aptitude install phpmyadmin 

 

Για να έχετε πρόσβαση στην phpMyAdmin για την ιστοσελίδα σας (π.χ 

http://example.com/phpMyAdmin/) πρέπει να συμπεριλάβετε την ακόλουθη 

γραμμή στο /etc/apache2/apache2.conf: 

 

Για να αρχίσετε να το χρησιμοποιείτε πηγαίνετε στο 

http://<SERVERIP>/phpmyadmin/. Χρησιμοποείστε την IP ή το όνομα του 

υπολογιστή/server αντί για <SERVERIP> (Η localhost IP είναι πάντα 127.0.0.1).) 

PHP: /etc/php5/apache2/php.ini 

Ένα συνηθισμένο πρόβλημα με τις ρυθμίσεις της PHP είναι η ενεργοποίηση της 

MySQL. Απλά επεξεργαστείτε το αρχείο και αποφύγετε την ακόλουθη γραμμή: 

# nano /var/www/apache2-default/test.php 

και εισάγεται τον ακόλουθο κώδικα : 

< ?php phpinfo(); ? > 

Include /etc/phpmyadmin/apache.conf 

Κάντε επανεκκίνηση τον Apache: 

# /etc/init.d/apache2 restart 

http://example.com/phpMyAdmin/
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(συμβουλή: αναζήτηση για MySQL) 

extension=mysql.so 

 

MySQL: /etc/mysql/my.cnf 

Μπορείτε να βρείτε και άλλα παραδείγματα στο 

/usr/share/doc/mysqlserver/examples 

3.9 Διαχείριση Moodle site 

Ο χρήστης που κάνει την εγκατάσταση του Moodle είναι και ο Administrator του 

site. Ωστόσο πολλές φορές ανατίθεται η διαχείριση του site σε άλλους χρήστες 

που έχουν το ρόλο του Manager. Παρακάτω περιέχονται κάποιες πληροφορίες για 

τη διαχείριση του Moodle site. 

• Authentication 

Το Moodle παρέχει πλήθος plugins που χρησιμοποιούνται για την 

αυθεντικοποίηση των χρηστών. Αυτά είναι: 

• Manual accounts 

Location: Administration > Site administration > Plugins > 

Authentication > Manage Authentication 

Ενεργοποιώντας αυτό το plugin η δημιουργία χρηστών μπορεί 

να γίνει μόνο από τον administrator. 

Ο administrator μπορεί να προσδιορίσει τη χρονική διάρκεια 

των κωδικών πρόσβασης και την περίοδο ενημέρωσης των 

χρηστών για την επικείμενη λήξη τους. Επίσης μπορεί να 

κλειδώσει κάποια πεδία. Αυτή ή επιλογή είναι χρήσιμη για site 

στα οποία ο administrator χειρίζεται και επεξεργάζεται τα 

δεδομένα των χρηστών χειροκίνητα ή επιτρέπεται στους 

χρήστες να ανεβάσουν στο site διάφορα αρχεία. 

Αυτό το plugin υποστηρίζει ακόμα δύο λειτουργίες που 

αναλύονται παρακάτω. Αυτές είναι: 

Adding a new user: Administrator > Site administration 

> Users > Accounts > Add a new user 

Adding users in bulk: Administration > Site 

administration > Users > Accounts > Upload users 

• No login 

Ο administrator μπορεί να κάνει “turn off’ ή suspend ένα λογαριασμό 

χρήστη επιλέγοντας “No login” στο “Choose an authentication method 

setting”. Κάθε χρήστης πρέπει να έχει μια μοναδική διεύθυνση email για το 
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προφίλ του στο Moodle, έστω και αν αυτό δεν είναι ενεργοποιημένο. Όταν 

ενεργοποιηθεί η παραπάνω ρύθμιση το email δεν μπορεί να 

ξαναχρησιμοποιηθεί για κάποιο άλλο λογαριασμό χρήστη στο Moodle. 

• Email-based self-registration 

Ο κάθε χρήστης μπορεί να δημιουργήσει το δικό του λογαριασμό 

από την αρχική σελίδα του site πατώντας “Create new account”. 

Συμπληρώνοντας τη φόρμα με τα στοιχεία του θα λάβει email για να 

ενεργοποιήσει το λογαριασμό του. Η ενεργοποίηση αυτού του plugin γίνεται 

από Administration > Site administration > Plugins > Authentication > 

Manage authentication. Προειδοποίηση: ενεργοποιώντας την αυτόματη 

εγγραφή χρήστη αυξάνεται η πιθανότητα να δημιουργηθούν κενά 

ασφαλείας με αποτέλεσμα τη δημιουργία spam accounts. Το ρίσκο μπορεί 

να περιορισθεί αν ενεργοποιήσετε την περιορισμένη εγγραφή χρηστών 

βάση των email. Για να το πετύχετε αυτό πηγαίνετε Administration > Site 

administration > Plugins > Authentication > Manage authentication. 

Εναλλακτικά, η αυτόματη εγγραφή χρηστών μπορεί να είναι ενεργή για 

κάποιο χρονικό διάστημα και μετέπειτα να απενεργοποιηθεί. 

Επιπροσθέτως μπορεί να ενεργοποιηθεί και το reCAPTCHA 

προστατεύοντας ακόμα περισσότερο από spammers και spam. 

Τέλος ο administrator μπορεί να ενεργοποιήσει το “Email 

confirmation message” το οποίο αποστέλλει αυτοματοποιημένο μήνυμα στο 

χρήστη. Η ενεργοποίηση γίνεται από Administration > Site administration > 

Language > Language customization. 

• No authentication 

Με αυτό το plugin κάθε χρήστης μπορεί να δημιουργήσει λογαριασμό 

στο Moodle χωρίς να ταυτοποιείται η εγκυρότητα του email του. Δεν 

συνιστάται η χρήση του παρά μόνο σε περιπτώσεις που θέλουμε να 

δοκιμάσουμε τις λειτουργίες του Moodle. Με αυτή την επιλογή μπορείτε να 

κλειδώσετε πεδία, να ενεργοποιήσετε και να απενεργοποιήσετε την 

πρόσβαση επισκεπτών και να παρέχετε μια εναλλακτική σελίδα σύνδεσης, 

με το ίδιο τρόπο όπως και άλλα authentication plugins. 

Ενεργοποιείται από: Settings > Site administration > Plugins > 

Authentication > Manage authentication. 

• CAS server (SSO): στοιχεία και λεπτομέρειες για τους λογαριασμούς 

χρηστών αποθηκεύονται στο εξωτερικό CAS server. Location: Settings > 

Site administration > Plugins > Authentication > Manage authentication. 

• External database: στοιχεία και λεπτομέρειες για τους λογαριασμούς 

χρηστών αποθηκεύονται σε εξωτερική βάση δεδομένων. Location: Settings 

> Site administration > Authentication > External database. 
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• FirstClass server: στοιχεία και λεπτομέρειες για τους λογαριασμούς 

χρηστών αποθηκεύονται στο εξωτερικό FirstClass server. Location: 

Settings > Site administration > Plugins > Authentication > Manage 

authentication. 

• IMAP server: στοιχεία και λεπτομέρειες για τους λογαριασμούς χρηστών 

αποθηκεύονται στο εξωτερικό IMAP server. Location: Settings > Site 

administration > Plugins > Authentication > Manage authentication. 

• LDAP server: στοιχεία και λεπτομέρειες για τους λογαριασμούς χρηστών 

αποθηκεύονται στο εξωτερικό LDAP server. Location: Settings > Site 

administration > Plugins > Authentication > Manage authentication. 

• Moodle Network authentication: σύνδεση διαφορετικών Moodle site και 

ταυτοποίηση των χρηστών. 

• NNTP server: στοιχεία και λεπτομέρειες για τους λογαριασμούς χρηστών 

αποθηκεύονται στο εξωτερικό NNTP server 

• PAM (Pluggable Authentication Modules): μπορείτε να χρησιμοποοιήσετε 

την ίδια βάση δεδομένων για διαφορετικές εφαρμογές log in (SSO – Single 

Sign On). Απαιτείται η εγκατάσταση του PAM authentication module. Για 

την ενεργοποίηση αυτού του plugin: Settings > Site administration > Plugins 

> Authentication > Manage Authentication. 

• POP3 server: στοιχεία και λεπτομέρειες για τους λογαριασμούς χρηστών 

αποθηκεύονται στο εξωτερικό POP3 server. Location: Settings > Site 

administration > Plugins > Authentication > Manage Authentication. 

• RADIUS authentication: στοιχεία και λεπτομέρειες για τους λογαριασμούς 

χρηστών αποθηκεύονται στο εξωτερικό RADIUS server. Location: Settings 

> Site administration > Plugins > Authentication > Manage Authentication. 

• Shibboleth: στοιχεία και λεπτομέρειες για τους λογαριασμούς χρηστών 

αποθηκεύονται στο εξωτερικό Shibboleth server. Location: Settings > Site 

administration > Plugins > Authentication > Manage Authentication. 

• Web services authentication. 
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ΕΠΙΛΟΓΟΣ 

Στο κεφάλαιο αυτό αρχικά αναλύονται οι απαιτήσεις για την εγκατάσταση 

του Moodle για λειτουργικό σύστημα Linux. Στη συνέχεια δίνονται αναλυτικές 

οδηγίες για τις απαιτούμενες ρυθμίσεις για τον server καθώς και για τη δημιουργία 

των directories και της νέας βάσης δεδομένων όπου θα εγκατασταθεί το Moodle. 

Έπειτα δίνονται αναλυτικές οδηγίες για την εγκατάσταση των τεχνολογιών που 

απαιτούνται για να λειτουργήσει το Moodle σε ένα λειτουργικό σύστημα. Επίσης 

γίνεται αναφορά στις οδηγίες για τη διαμόρφωση του LAMP καθώς και εντολές για 

να ελέγξετε τη σωστή εγκατάσταση. Τέλος παρέχονται πληροφορίες σχετικά με τη 

διαχείριση ενός Moodle site. 
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ΚΕΦΑΛΑΙΟ 4 

Courses 
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ΕΙΣΑΓΩΓΗ 

Τα Courses στο Moodle μπορεί να είναι κάποιοι πόροι ή δραστηριότητες 

που αναρτώνται από τους καθηγητές και οι μαθητές πρέπει να τις υλοποιήσουν. 

Ένα course μπορεί να είναι μια απλή σελίδα η οποία περιέχει υλικό που είναι 

διαθέσιμο για downloading ή μπορεί να είναι μια σύνθετη εργασία στην οποία θα 

εκπαιδευτούν διαδραστικά οι μαθητές. Οι καθηγητές είναι οι διαχειριστές των 

courses. Η εγγραφή των μαθητών σε ένα course μπορεί να γίνει από τον 

καθηγητή του μαθήματος, αυτόματα από τον διαχειριστή ή ο διαχειριστής να δώσει 

δικαιώματα στους μαθητές ώστε να εγγραφούν από μόνοι τους. Οι μαθητές μπορεί 

να ενταχθούν σε groups είτε επειδή μοιράζονται το ίδιο υλικό είτε επειδή πρέπει να 

διαφοροποιηθούν από το σύνολο. 

Οι πόροι, που αναφέρονται παραπάνω, είναι συνήθως στατική πληροφορία, 

αρχείο ή κάποιος σύνδεσμος. Το Moodle υποστηρίζει πλήθος πόρων που οι 

καθηγητές μπορούν να προσθέσουν στα courses. Για να προσθέσει πόρους σε 

κάποιο course ο καθηγητής πρέπει να βρίσκετε σε Edit mode και να πατήσει στο 

σύνδεσμο ‘Add an activity or resource’. Οι πόροι αυτοί είναι: 

• Book 

• File – μπορεί να είναι κάποιο pdf αρχείο, μια εικόνα, αρχείο ήχου ή βίντεο, 

λογιστικό φύλλο 

• Folder 

• IMS content package – στατικό υλικό σε μορφή IMS 

• Label – είναι ένα ξεχωριστό τμήμα του course page στο οποίο μπορεί να 

προστεθεί κείμενο, εικόνα, πολυμέσα ή κώδικας μεταξύ άλλων πόρων στα 

διάφορα τμήματα του course page. 

• Page – HTML page 

• URL 

Οι δραστηριότητες είναι η διάδραση που μπορεί να έχουν μεταξύ τους οι μαθητές 

ή/και με τους καθηγητές σε ένα course page. Υπάρχουν 14 διαφορετικές 

δραστηριότητες που αναφέρονται επιγραμματικά παρακάτω: 

• Assignments 

• Chat 

• Choice 

• Database 

• External tool 

• Feedback 

• Forum 

• Glossary 

• Lesson 

• Quiz 

• SCORM 
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• Survey 

• Wiki 

• Workshop 

Τα courses είναι υλικό που προστίθεται στο Moodle από τους καθηγητές για 

τους μαθητές. Μπορούν να τα δημιουργήσουν οι administrators, managers και οι 

course creators. Οι καθηγητές είναι αυτοί που οργανώνουν το υλικό των 

μαθημάτων σύμφωνα με τις ανάγκες τους. Παρακάτω γίνεται ανάλυση για το πώς 

δημιουργείται ένα μάθημα, πως οργανώνεται και πως γίνεται εύκολα διαχειρίσιμο. 

4.1.1 Δημιουργία course 

Ένα course δημιουργείται εξ ορισμού από τον administrator, τον manager 

και τον course creator. Εξ ορισμού τα capabilities του course creator ανατίθενται 

στους χρήστες με ρόλο “teacher” του Moodle. Για τη δημιουργία μαθήματος: 

 Administration > Site administration > Courses > Manage courses and 

categories. 

 Επιλέγετε, ή δημιουργείτε, κατηγορία στην οποία θέλετε να εντάξετε το 

μάθημα. 

 Επιλέγετε “New course”. 

 Συμπληρώνεται τα χαρακτηριστικά του μαθήματος και επιλέγετε “Save 

changes”. 

 Τέλος επιλέγετε τους καθηγητές και μαθητές που θέλετε να εντάξετε στο 

μάθημα. 
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4.1.2 Διαγραφή course 

Ένα course μπορεί να το διαγράψει ένας καθηγητής ο οποίος μπορεί και να 

το δημιουργήσει. Οποιοσδήποτε άλλος καθηγητής δεν μπορεί να διαγράψει 

κανένα course. Επίσης οι administrators και οι managers μπορούν να διαγράψουν 

ένα μάθημα, στους οποίους παρέχεται εξ ορισμού capability moodle/course:delete 

για διαγραφή μαθήματος. 

Για τη διαγραφή ενός μαθήματος: 

• Administration > Site administration > Courses > Manage 

course and categories. 

• Επιλέγετε την κατηγορία στην οποία ανήκει το μάθημα, 

επιλέγετε το μάθημα στα δεξιά της οθόνης. 

• Επιλέγετε ‘Delete’. 

Για να διαγράψετε πολλά μαθήματα: 

• Δημιουργήστε μία προσωρινή κατηγορία μαθημάτων. 
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• Επιλέξτε και μεταφέρετε τα μαθήματα που επιθυμείτε στην 

προσωρινή κατηγορία. 

Διαγράψτε την κατηγορία και επιλεξτε “Delete ALL – cannot be undone”. 

 

4.1.3 Course request 

Τα Course request ενεργοποιούνται από: Settings > Site administration > 

Courses > Course request. Ο administrator μπορεί να θέσει στην κύρια κατηγορία 

των courses, miscellaneous όπως χαρατκηριστικά αναφέρεται, τη δυνατότητα 

στους χρήστες να θέσουν αίτημα για δημιουργία νέου course. Οι χρήστες με 

capability moodle/site:approvecourse θα λάβουν ειδοποίηση για “Course request”. 

Ενεργοποιώντας αυτή τη δυνατότητα, στη σελίδα με τα courses θα εμφανιστεί ένα 

κουμπί “Requset a new course” και όλοι οι πιστοποιημένοι χρήστες του Moodle 

μπορούν να υποβάλουν “Course request”. 

4.1.3.1 Ρόλος Course requester 

Ο ρόλος “Course requester” μπορεί να δημιουργηθεί για να περιορίσετε 

τους χρήστες οι οποίοι μπορούν να υποβάλουν “Course request”. 

4.1.3.1.1 Διαγραφή χρηστών με capability για “Course request” 

Εξ ορισμού όλοι οι πιστοποιημένοι χρήστες του Moodle μπορούν να 

υποβάλουν “Course request”. Για να το αλλάξετε αυτό: 

1. Από: Administration > Users > Permissions > Define roles. 

2. Πατήστε “Edit” στο ρόλο “Authenticated role” και θέστε για το capability 

moodle/course:request να μην επιτρέπεται (Not set). 

3. Πηγαίνετε στο τέλος της σελίδας και πατήστε “Save changes”. 

4.1.3.1.2 Δημιουργία νέου ρόλου 

1. Από: Administration > Users > Permissions > Define roles. 

2. Πατήστε “Add a new role”. 

3. Δώστε ένα όνομα για το ρόλο π.χ. “Course requester” και περιγραφή. 

4. Επιλέξτε “System” στο “Contex types where this role may be assigned”. 

5. Αλλάξτε το capability moodle/course:request σε “Allow”. 

6. Πατήστε το κουμπί “Create this role”. 
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Σημείωση: είναι απαραίτητο να δημιουργήσετε το ρόλο αυτό και όχι να 

αλλάξετε τα capability για το ρόλο του καθηγητή, διότι πρέπει να αποδίδεται ως 

ρόλος του Moodle. O ρόλος του καθηγητή είναι συνυφασμένος με τη διαχείριση 

των courses και των Course categories. 

4.1.3.1.4 Ανάθεση ρόλου σε χρήστη 

1. Από: Administration > Users > Permissions > Assign sytem roles. 

2. Επιλέξτε το ρόλο που δημιουργήσατε παραπανω (Course requester). 

3. Επιλέξτε έναν ή περισσότερους χρήστες από τη λίστα “Potential users” 

στους οποίους θέλετε να αναθέσετε αυτό το ρόλο. 

4.1.4 Bulk course creation 

Από: 

• Administration > Site administration > Courses > Upload courses. 

• Upload a CSV αρχείο είτε με drag and drop είτε από το File picker. 

• Επιλέξτε τα χαρακτηριστικά για το αρχείο και πατήστε “Preview” και μετά 

Upload. 

4.1.5 Πρότυπα για courses 

Μπορείτε να επιλέξετε κάποιο template για να δημιουργήσετε κάποιο 

course από: 

• Administration > Site Administration > Courses > Upload courses. 

Κατά αρχάς θα πρέπει να δημιουργήσετε ή να τοποθετήσετε στο Moodle 

ένα course το οποίο και επιθυμείτε να χρησιμοποιήσετε ως template. Το 

course αυτό θα πρέπει να έχει κάποια σταθερά χαρακτηριστικά όπως ο 

τίτλος για παράδειγμα. Πρέπει να σημειωθεί ότι χρησιμοποιώντας ένα 

course template ανακτώνται τα στοιχεία του και όχι τα χαρακτηριστικά του - 

settings. 

Μέθοδος 1 

• Δημιουργήστε ένα αρχείο CSV 

• Από: Administration > Site administration > Courses > Upload courses κάντε 

upload το αρχείο σας. 

• Πατήστε “Preview” και κατεβείτε στο “Course process”. Στο πεδίο “Restore 

from this course after upload”, δώστε ένα όνομα για το template course. 

• Κάντε “Upload file”. 
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Μέθοδος 2 

Στο csv file θα πρέπει να επιλέγονται όλα τα χαρακτηριστικά για το template 

course. Ακολουθεί ένα παράδειγμα csv file το οποίο περιέχει το theme, language, 

enrolment method and alternative names για τους καθηγητές και τους μαθητές. 

shortname,fullname,category,newsitems,theme,lang,format,enrolment_1,enrolmen 

t_1_role,role_student,role_teacher,templatecourse 

Knit,Knitting,2,0,afterburner,fr,topics,manual,student,NewKnitter,MasterKnitter,OM 

T 

4.1.6 Χρήση αποθηκευμένου προτύπου για course 

Επίσης υπάρχει η δυνατότητα να χρησιμοποιήσετε ως template course ένα 

ήδη αποθηκευμένο αρχείο csv. Για να γίνει αυτό: 

• Δημιουργήστε ένα CSV file. 

• Από Administration > Site administration > Courses > Upload 

courses επιλέξτε το αρχείο. 

• Κάντε “Preview” και κατεβείτε στο “Course process”. Στο πεδίο 

“Restore from this file after upload” επιλέξτε το ήδη αποθηκευμένο 

αρχείο που θέλετε να χρησιμοποιήσετε ως template. 

• Εναλλακτικά, μπορείτε να καθορίσετε τα χαρακτηριστικά – settings 

(format, enrollment methods, language) σε ένα αρχείο csv. Αυτός ο 

τρόπος θεωρείται καταλληλότερος όταν πρόκειται να 
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χρησιμοποιήσετε διαφορετικά courses που θα έχουν τα ίδιο template 

με διαφορετικά settings. 

• Κάντε “Upload file” 

4.2.1 Upload courses 

Η λειτουργία αυτή επιτρέπει στον administrator να κάνει upload courses, είτε 

είναι courses που μόλις δημιουργήθηκαν είτε είναι courses τα οποία θα 

χρησιμοποιηθούν ως templates. Επίσης επιτρέπει το update αλλά και την 

διαγραφή courses. Για κάνετε upload ένα ή περισσότερα courses από: 

• Administration > Site administration > Courses > Upload courses. 

• Κάντε upload είτε με drag and drop είτε επιλέγοντας το CSV αρχείο 

από το file picker “Choose a file”. 

• Κάντε τις κατάλληλες ρυθμίσεις και πατήστε “Preview”. 

 

Σημείωση: μπορείτε να χρησιμοποιήσετε και το command-line tool – 

admin/tool/uploadcourse/cli/uploadcourse.php. 

4.2.2 Δημιουργία course σε αρχείο 

Όταν δημιουργείτε ένα αρχείο για upload αυτό θα πρέπει να είναι της 

μορφής CSV. Τα πεδία που περιέχει διαιρούνται σε δύο κατηγορίες, η μία είναι τα 

course information και η άλλη τα course actions. 

4.2.3 Πεδία πληροφοριών του course 

Πολλά από αυτά τα settings εμφανίζονται και στα settings ενός course. Τα 

ονόματα των πεδίων θα πρέπει να είναι με πεζά γράμματα. 

shortname: σύντομη ονομασία 

fullname: πλήρες όνομα 

idnumber: αριθμός ID 
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category: το ID της κατηγορίας που θα τοποθετήσετε το course. Αυτό υπερισχύει 

των category_idnumber and category_path. 

category_idnumber: ο αριθμός ID της κατηγορίας. Αυτό υπερισχύει 

του category_path. 

category_path: η διαδρομή της κατηγορίας που θα τοποθετήσετε το course. Αν 

για παράδειγμα θέλετε να τοποθετήσετε ένα course με όνομα “Java Programming” 

κάτω από την κατηγορία “Development” η διαδρομή θα είναι: Development / Java 

Programming. 

Σημείωση 1: ο διαχωρισμός πρέπει να είναι [κενό]/[κενό]. 

Σημείωση 2: η κατηγορία στην οποία θα προσθέσετε το course πρέπει να 

υπάρχει και όχι να δημιουργηθεί σε μεταγενέστερο χρόνο. Αν θέλετε να 

τοποθετήσετε το course στην κατηγορία ανώτερου επιπέδου “Development” τότε 

στο πεδίο πρέπει να βάλετε “Development”. 

visible: θα έχει την τιμή 1 αν είναι ορατό και 0 αν δεν είναι ορατό 

startdate: ημερομηνία που το course ξεκινάει. 

summary: η περίληψη του course. 

format: το course format που χρησιμοποιείτε, θα πρέπει να υπάρχει ένα έγκυρο 

όνομα για το. π.χ weeks, topics. theme: το θέμα που χρησιμοποιείτε lang: η 

γλώσσα που χρησιμοποείτε newsitems: ο αριθμός των νέων στοιχείων 

showgrades: θα έχει την τιμή 1 όταν οι μαθητές μπορούν να δουν το βαθμολόγιο 

και 0 όταν δεν μπορούν να το δουν. 

showreports: θα έχει την τιμή 1 όταν οι χρήστες μπορούν να δουν τα activity 

reports και 0 όταν δεν μπορούν να τα δουν. 

legacyfiles: θα έχει την τιμή 1 όταν είναι ενεργοποιημένα τα legacy course files 

και 0 όταν δεν είναι ενεργοποιημένα. 

maxbytes: το μέγιστο μέγεθος του course σε bytes για upload. 

groupmode: τιμή 0 για No groups, 1 για Separate groups και 2 για Visible groups. 

groupmodeforce: θέστε τιμή 1 για να χρησιμοποιείτε το group και 0 σε κάθε 

άλλη περίπτωση. 

enablecompletion: τιμή 1 για να ενεργοποιήσετε το activity completion και 0 για 

να είναι ανενεργό. 

4.2.4 Πεδία εγγραφής 

Ορισμένα πεδία μπορεί να κατασκευαστούν για την ενεργοποίηση και τη 

διαμόρφωση των enrolments methods. Τα πεδία αυτά θα πρέπει να έχουν το 

όνομα enrolment_[number] για το όνομα του enrolment method και 

enrolment_[number]_property για τα properties. 

enrolment_[number]: το όνομα του enrolment method. 

enrolment_[number]_delete: τιμή 1 για να διαγράψετε τη μέθοδο εγγραφής από 

το course, αν θέσετε την τιμή 1 όλες οι άλλες ιδιότητες αγνοούνται. 
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enrolment_[number]_disable: 1 για να απενεργοποιήσετε τη μέθοδο εγγραφής 

από το course, αν θέσετε την τιμή 1 όλες οι άλλες ιδιότητες αγνοούνται.. 

enrolment_[number]_startdate: ημερομηνία έναρξης της διαδικασίας εγγραφής. 

Η τιμή αυτή μεταβιβάζεται στη function strtotime() της PHP. 

enrolment_[number]_enddate: ημερομηνία τερματισμού της διαδικασίας 

εγγραφής. Η τιμή αυτή μεταβιβάζεται στη function strtotime() της PHP. 

enrolment_[number]_enrolperiod: χρονική διάρκεια (σε sec) της διαδικασίας 

εγγραφής. 

enrolment_[number]_role: σύντομο όνομα ρόλου. 

enrolment_[number]_[property]: σε περίπτωση που η ιδιότητα είναι κατανοητή 

από την καθορισμένη μέθοδο εγγραφής.                               

enrolment_[number]_password: κωδικός για την διαδικασία εγγαφής. 

Παράδειγμα 

enrolment_1: manual  

enrolment_1_role: student  

enrolment_1_enrolperiod: 1 month 

enrolment_2: self  

enrolment_2_startdate: 2013-01-30 

4.2.5 Μετονομασία ρόλων 

Για τη μετονομασία ρόλων πρέπει να χρησιμοποιήσετε το πρότυπο: 

role_[shortname] 

 [shortname] το νέο όνομα του ρόλου 

Παράδειγμα 

role_student: Apprentice 

role_teacher: Master 

role_mycustomrole: Jedi 

4.2.6 Course action fields 

Αυτά τα settings υπερισχύουν από τις παραμέτρους των Course. 

delete: θέστε την τιμή 1 για να διαγράψετε το course. 

rename: σύντομο όνομα για μετονομασία του course. 

backupfile: η απόλυτη διαδρομή για ένα αρχείο αντίγραφο ασφαλείας 

(.mbz) για να το εισάγεται σε ένα course. Απαιτεί το πλήρες μονοπάτι για το 

course. Για παράδειγμα: 

/home/yourmoodle/public_html/moodle27/transfert/backup.mbz. Για να δείτε 
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τις πληροφορίες για το πλήρες μονοπάτι στο δικό σας Moodle: Site 

administration > Server > PHP info. 

templatecourse: το σύντομο όνομα ενός course για την εισαγωγή του 

περιεχομένου. 

reset: θέστε την τιμή 1 για να επαναφέρετε το course 

4.2.7 Υποχρεωτικά πεδία 

shortname: αυτό το πεδίο είναι υποχρεωτικό σε κάθε περίπτωση με 

μοναδική εξαίρεση τη δημιουργία νέου course. 

fullname: απαιτείται κάθε φορά που δημιουργείτε νέο course.        

category, category_idnumber, category_path: ένα από αυτά απαιτείται 

όταν δημιουργείται course. 

4.2.8 Επιλογές εισαγωγής 

Upload mode: αυτή η επιλογή σας επιτρέπει να καθορίσετε αν ένα course 

μπορεί να δημιουργηθεί και ή/και να ενημερωθεί (update). 

Update mode: αυτή η επιλογή σας επιτρέπει να ενημερώσετε τα courses 

επιλέγοντας και το εργαλείο για ενημέρωση. 

Allow deletes: το πεδίο διαγραφής θα είναι ενεργό ή όχι. 

Allow renames: το πεδίο μετονομασίας θα είναι ενεργό ή όχι. 

Allow resets: το πεδίο επαναφοράς θα είναι ενεργό ή όχι. 

4.2.9 Διαδικασία course 

Σας επιτρέπει να καθορίσετε τις ενέργειες που πρέπει να γίνουν για τα 

μαθήματα που οι χρήστες κάνουν upload. 

Shortname template:. Αν δημιουργήσετε course χωρίς να εισάγετε το shortname 

μπορείτε να χρησιμοποιήσετε αυτό το πεδίο για να δημιουργηθεί αυτόματα ένα 

shortname. Χρησιμοποιούνται δύο δείκτες για αυτό το πεδίο: %i για το ID number 

και %f για το summary. 

Restore file: Σας δίνει τη δυνατότητα να εισάγετε ένα course, το οποίο υπάρχει 

ήδη σε μορφή .mbz, μετά από τη δημιουργία ή το update. 

Restore from course: Το shortname του course για να εισάγετε το στοιχείο μετά 

από τη δημιουργία ή το update. 

Reset after upload: Επιλογή για το αν μπορείτε να κάνετε reset το course μετά 

από τη δημιουργία ή το update. 

Αυτές είναι οι τιμές μπορούν να ρυθμιστούν στο web interface του Moodle 

για όλα τα πεδία που δεν προσδιορίζονται στο CSV αρχείο. Αυτά 

χρησιμοποιούνται πάντα κατά τη δημιουργία ενός course αλλά μόνο όταν γίνεται 

δημιουργία με τη μέθοδο του upload course. Κατά την εισαγωγή των στοιχείων σε 

ένα backup αρχείο ενεργοποιήστε στη ρύθμιση keeptemptdirectoriesonbackup. Με 

αυτό τον τρόπο επιταχύνεται σημαντικά η διαδικασία upload εάν κάνετε upload 

πολλές φορές από την ίδια πηγή. 
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4.3 Κατηγορίες course 

Για την καλύτερη παρακολούθηση των courses μπορείτε να τα οργανώσετε 

σε κατηγορίες. Εξ ορισμού το Moodle προσφέρει μία κατηγορία courses με την 

ονομασία “Miscellaneous”, η οποία μπορεί να μετονομαστεί. Οι χρήστες που 

μπορούν να εντάξουν κάποιο course στην κατηγορία Miscellaneous είναι οι 

administrators, managers και οι course creators. Εξ ορισμού στο Moodle σε μια 

κατηγορία courses εμφανίζονται οι teachers που συμμετέχουν όπως και η 

περίληψη – summary του course. Αν ο αριθμός των μαθημάτων σε μια κατηγορία 

υπερβαίνει τα 9 (είναι 10 ή περισσότερα) τότε εμφανίζεται μία λίστα με τα courses 

χωρίς να περιέχονται σε αυτή οι teachers και summary των courses. 

 

4.3.1 Προσθέστε μία κατηγορία course 

Τα courses συνήθως κατηγοριοποιούνται ανά τμήμα ή ανά θέμα. Για να 

δημιουργήσετε μια νέα κατηγορία course: 

• Administration > Site administration > Courses > Add a 

category. 

• Συμπληρώστε τις πληροφορίες που απαιτούνται και πατήστε 

“Create category”. 

• Εναλλακτικά, Administration > Site administration > Courses > 

Manage courses and categories και πατήστε “Create new 

category”. 
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4.3.2 Προσθέστε μία υπό-κατηγορία course 

Πολλές φορές είναι χρήσιμο να έχετε υπο-κατηγορίες για τα course. Για 

παράδειγμα έχετε την κατηγορία Επιστήμη και υπο-κατηγορίες Βιολογία, Φυσική, 

Χημεία. Για να δημιουργήσετε μια κατηγορία ως υπο-κατηγορία κάποιας άλλης θα 

πρέπει να επιλέξετε στα αριστερά την κατηγορία που θέλετε και στο drop down list 

μενού “Move selected categories to”. Για να δημιουργήσετε μία νέα υπο-κατηγορία 

επιλέξτε από Administration > Site administration > Courses > Manage courses 

and categories και πατήστε “Create new subcategory”. 

4.3.3 Απόκρυψη-Εμφάνιση κατηγοριών 

Για να αποκρύψετε ή να εμφανίσετε μία κατηγορία πηγαίνετε Administration 

> Site administration > Courses > Manage courses and categories και πατήστε το 

εικονίδιο “eye” στην κατηγορία την οποία επιθυμείτε να αποκρύψετε ή να 

εμφανίσετε. Τις κατηγορίες που έχετε αποκρύψει μπορούν να τις δουν οι 

administrators του Moodle site και αυτοί οι οποίοι έχουν capability “view hidden 

courses”. Μπορείτε επίσης να περιορίσετε το αριθμό των κατηγοριών που 

εμφανίζονται στην πρώτη σελίδα επιλέγοντας “List of categories” ή “Combo list” 

από Administration > Site administration > Front page > Front page settings. 

4.3.4 Εγγραφή χρηστών σε κατηγορίες 

Το category enrolments plugin δίνει τη δυνατότητα στους χρήστες να 

εγγραφούν σε μια κατηγορία courses. Το plugin ενεργοποιείται από τον 

administrator και συγχρονίζει οποιοδήποτε ρόλο έχει capability 

“enrol/category:synchronized”. Προτείνεται όμως για την παραπάνω λειτουργία να 

χρησιμοποιείτε Cohort sync. Για την ενεργοποίηση του plugin: Administration > 

Site administration > Plugins > Enrolments > Manage enrol plugins. 

4.3.4.1 Ρυθμίσεις 

• Πηγαίνετε στην κατηγορία στην οποία θέλετε να κάνετε enrol τους χρήστες 

• Στο Administration block πατήστε “Assign roles” και θα εμφανιστούν οι 

χρήστες (roles) που μπορείτε να τους εκχωρήσετε. 
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4.3.4.2 Εκχώρηση καθηγητών ή μαθητών σε κατηγορία 

Εξ ορισμού μόνο οι managers και οι course creators μπορούν να 

εκχωρηθούν σε μια category-wide. Για να εκχωρήσετε teachers και students θα 

πρέπει o administrator να επιλέξει το box στον αντίστοιχο ρόλο που θέλει να 

εκχωρήσει από Administration > Site administration > Users >Permissions > 

Define roles. 

Για να σιγουρευτείτε ότι εκχωρούνται αυτόματα οι ρόλοι teachers/students σε κάθε 

νέο course που δημιουργείτε ο administrator θα πρέπει να θέσει capability 

“enrol/category:synchronised” σε allow για τον κάθε ρόλο. 

 

4.4 Ρυθμίσεις course 

Για να κάνετε ρυθμίσεις για το course από το Administration block της 

σελίδας του course πατήστε Settings. 

 

4.4.1.1 Όνομα course 

Αυτό θα είναι το όνομα με το οποίο θα εμφανίζεται το course σε κάθε σελίδα 

του course αλλά και στη σελίδα όλων των μαθημάτων. Το όνομα θα πρέπει να 
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είναι περιγραφικό και σύντομο ώστε να μπορεί το course να εντοπιστεί εύκολα. 

Την ονομασία μπορούν να την αλλάξουν και να την επεξεργαστούν οι καθηγητές 

και οι managers του μαθήματος (εξ ορισμού capabilities). 

4.4.1.2 Short name 

Η ιδιότητα αυτή αποτελεί έναν εναλλακτικό τρόπο αναφοράς στο course. 

Χρησιμοποιείται σε σημεία όπου το Full name δεν είναι κατάλληλο όπως στο 

Navigation block. Εξ ορισμού μόνο τα Full names εμφανίζονται στον κατάλογο των 

courses. Ωστόσο ο administrator μπορεί να ενεργοποιήσει τα Short names να 

εμφανίζονται επιλέγοντας από Administration > Site administration > Appearance 

> Courses. Με το capability moodle/course:changeshortnames ελέγχετε αν ο 

χρήστης μπορεί να αλλάξει το όνομα στο Short name. 

4.4.1.3 Κατηγορίες course 

Ο administrator του Moodle site μπορεί να δημιουργήσει categories για τα 

courses ώστε οι χρήστες να διευκολύνονται για τον εντοπισμό των μαθημάτων. Η 

επιλογή αυτή καθορίζει την κατηγορία στην οποία ανήκει και εμφανίζεται το 

course. 

4.4.1.4 Visible 

Θέτοντας τη ρύθμιση αυτή στο “Hide” τότε το εν λόγω course δεν θα 

εμφανίζεται σε καμία λίστα με courses. Οι μόνοι χρήστες στους οποίους θα 

εμφανίζεται είναι αυτοί που έχουν capability: view hidden courses και αυτοί είναι οι 

managers, teachers , course creators. Αν κάποιος μαθητής προσπαθήσει να έχει 

πρόσβαση στο course μέσω URL δεν θα εμφανίζεται το course. Σημείωση: σε 

παλαιότερες εκδόσεις του Moodle η ρύθμιση αυτή αναφερόταν ως ”Course 

availability”. 

4.4.1.5 Ημερομηνία έναρξης του course 

Η ημερομηνία έναρξης είναι η ημέρα που ξεκινάει να είναι ενεργό προς τους 

χρήστες το course. Αν χρησιμοποιείτε Weekly format τότε το course θα αρχίζει 

από την ημερομηνία που ορίζεται σε αυτό το πεδίο. 

4.4.1.6 Αριθμός ID του course 

Το ID number ενός course μπορεί να είναι αλφαριθμητικό. Σε γενικές 

γραμμές δεν είναι εμφανές στους μαθητές. Ωστόσο μπορεί να χρησιμοποιηθεί για 

την ταυτοποίηση του μαθήματος σε εξωτερικά συστήματα ή μπορεί να 

χρησιμοποιηθεί για την ταυτοποίηση ως τυπωμένο πεδίο. 

4.4.2 Περιγραφή του course 

Παρακάτω βλέπετε μία εικόνα από το Moodle για την περιγραφή του course. 
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4.4.2.1 Περίληψη για το course και των αρχείων 

Στο Course summary ο χρήστης μπορεί να γράψει μια περίληψη για το εν 

λόγω course. Επίσης μπορεί να προσθέσει και εικόνα στο course ή αν το 

επιτρέπει ο administrator, με τις κατάλληλες ρυθμίσεις από Administration > Site 

administration > Appearance > Courses, μπορεί να προσθέσει και άλλους τύπους 

αρχείων. Εξ ορισμού ο χρήστης μπορεί να προσθέσει αρχεία μορφής jpg, gif και 

png. Χρήστες οι οποίοι δεν είναι εγγεγραμμένοι στο course θα μπορούν να δουν 

μόνο το όνομα και την περίληψη του course. Χρήστες με capability 

moodle/course:changesummary μπορούν να κάνουν upload/change αρχεία στο 

summary files. Σημείωση: αν ο administrator δεν έχει κάνει τις κατάλληλες 

ρυθμίσεις δεν θα εμφανίζεται το πλαίσιο με τα summary files. 

4.4.3 Μορφή του course 

Σε αντίθεση με ορισμένα CMS που σας αναγκάζουν να έχετε ένα 

συγκεκριμένο format, το Moodle σας παρέχει έναν αριθμό επιλογών για το format 

των courses. Μπορείτε να καθορίσετε τον τύπο του course χρονολογικά κατά 

εβδομάδα, με βάση το θέμα ή να επιλέξετε να το οργανώσετε σε ένα μεγάλο forum 

ή σε ένα κουίζ. Για να επιλέξετε το course format από Administration > Course 

administration > Edit settings. Ο administrator μπορεί να ενεργοποιήσει, 

απενεργοποιήσει ή να διαγράψει τα course formats από Administration > Site 

administration > Plugins > Course formats > Manage course formats. Επίσης 

μπορεί να αλλάξει τη σειρά με την οποία τα course formats εμφανίζονται στους 

καθηγητές στις ρυθμίσεις για τα courses. 
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4.4.3.1 Weekly format 

Με αυτό το format μπορείτε να καθορίσετε την ημερομηνία έναρξης και 

λήξης του course οργανώνοντάς το χρονολογικά σε εβδομάδες. Το Moodle θα 

δημιουργήσει για κάθε εβδομάδα και μία ενότητα στην οποία μπορείτε να 

προσθέσετε υλικό για το course, forums, quiz και άλλα. Αποτελεί καλή επιλογή 

όταν θέλετε όλοι οι μαθητές να έχουν πρόσβαση στο ίδιο υλικό του course. 

 

4.4.3.2 Topics format 

Το course οργανώνεται σε ενότητες και ο καθηγητής μπορεί να προσθέσει 

διάφορες δραστηριότητες και πόρους για το course. Το format αυτό είναι καλή 

επιλογή όταν οι μαθητές και συμμετέχοντες σε αυτό δεν είναι αναγκασμένοι να 

ακολουθούν ένα συγκεκριμένο χρονοδιάγραμμα. 

 

4.4.3.3 Social format 

Αυτό το format προσανατολίζεται γύρω από ένα κεντρικό forum το οποίο 

εμφανίζεται στη σελίδα με τη λίστα των courses. Είναι χρήσιμο για καταστάσεις 

στις οποίες θέλετε να παρουσιάσετε ένα course σε πιο ελεύθερη μορφή δηλαδή 

κάτι σαν ένα ανεπίσημο course. Και σε αυτό το course format μπορείτε να 
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προσθέσετε δραστηριότητες και υλικό για το course. Καλό παράδειγμα αποτελεί το 

Moodle Lounge. 

 

4.4.3.4 Single activity format 

Επιλέγοντας αυτό το format το course θα περιέχει μία και μόνο ενότητα, 

στην οποία ο καθηγητής μπορεί να εντάξει μία δραστηριότητα από το dropdown 

μενού. Το format αυτό είναι παρόμοιο με το Social format με τη διαφορά ότι 

εμφανίζεται η δραστηριότητα ως μια και μοναδική οντότητα για το course. 

Σημείωση: σε παλαιότερες εκδόσεις του Moodle αυτό το format εμφανιζόταν ως 

SCORM format. Τώρα το SCORM εμφανίζεται ως δραστηριότητα του Single 

activity format στο dropdown menu. 

 

Τέλος πρέπει να αναφερθεί ότι το Moodle community έχει αναπτύξει και 

άλλα course formats τα οποία είναι διαθέσιμα και μπορούν να χρησιμοποιηθούν 

ως plugins. Αναφέρουμε επιγραμματικά κάποια από αυτά: Daily format, Grid 

format, Menutopic format, Noticeboard format και πολλά άλλα. 

4.4.3.5 Number of sections 

Αυτή η ρύθμιση είναι διαθέσιμη μόνο για Weekly και Topics course formats. 

Για το Weekly format καθορίζει τον αριθμό των εβδομάδων που θα ορίσετε. Για το 
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Topics format καθορίζει τον αριθμό των ενοτήτων του course. Αν ορίσετε για τον 

αριθμό εβδομάδων/ενοτήτων 0 (μηδέν) τότε θα εμφανίζεται στη σελίδα του 

μαθήματος μια γενική μορφή του course. Εξ ορισμού ο αριθμός των 

εβδομάδων/ενοτήτων που μπορείτε να ορίσετε είναι 52 αλλά ο administrator 

μπορεί να ορίσει διαφορετικό αριθμό που θα ισχύει για όλα τα course στο Moodle 

site. 

4.4.3.6 Hidden sections 

Αυτή η ρύθμιση σας δίνει τη δυνατότητα να επιλέξετε αν θα εμφανίζονται 

κρυμμένες ενότητες στους μαθητές. Είναι ιδιαίτερα χρήσιμη στο Weekly format ή 

αν έχετε κουίζ τα οποία δεν θέλετε να δουν οι μαθητές. Συμβουλή: μπορείτε να 

επιλέξετε αυτά τα στοιχεία να είναι εντελώς κρυμμένα έτσι ώστε οι μαθητές να μην 

γνωρίζουν καν ότι υπάρχουν στο course κρυμμένες δραστηριότητες. 

4.4.3.7 Course layout 

Η ρύθμιση αυτή καθορίζει αν η πορεία του course θα εμφανίζεται σε μία ή 

περισσότερες σελίδες. Οι καθηγητές επιλέγουν αν οι ενότητες θα εμφανίζονται σε 

μία σελίδα ή κάθε ενότητα θα εμφανίζεται σε μία σελίδα. 

 

4.4.4 Appearance 

 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

54 από 132 

4.4.4.1 Force language 

Επιλέγοντας μία γλώσσα σε αυτό το σημείο, το Moodle εξαναγκάζει τους 

χρήστες να το χειρίζονται με αυτή τη γλώσσα. Το moodle/site:forcelanguage 

capability επιτρέπει στον administrator να δώσει τη δυνατότητα στους χρήστες να 

παρακάμψουν τη γλώσσα χρήσης. 

4.4.4.2 New items to show 

Αυτή η ρύθμιση καθορίζει πόσα πρόσφατα στοιχεία εμφανίζονται στο Latest 

news block της σελίδας του course. Αν τεθεί στο 0 (μηδέν) δεν θα εμφανίζεται 

κανένα. 

 

4.4.4.3 Show gradebook to students 

Αυτή η ρύθμιση καθορίζει αν ένας μαθητής μπορεί να δει τις αξιολογήσεις 

του για το course στο οποίο συμμετέχει από το Administration block. Αν δεν 

χρησιμοποιείτε αξιολογήσεις τότε μπορείτε να το αφήσετε απενεργοποιημένο. Αν 

στο Administration block δεν εμφανίζεται ο σύνδεσμος τότε οι μαθητές μπορούν να 

δουν τις αξιολογήσεις τους από το Assignment module. 

4.4.4.4 Show activity reports 

Η ρύθμιση αυτή καθορίζει αν ένας μαθητής μπορεί να δει δικά του Activity 

reports. Αυτά μπορεί να περιέχουν δημοσιεύσεις σε forum, αρχεία καταγραφής 

πρόσβασης. Η ρύθμιση αυτή επιβαρύνει τον sever με επιπλέον φόρτο γι’ αυτό και 

είναι εξ ορισμού απενεργοποιημένη. Τα Course Activity reports μπορούν να τα 

δουν οι managers, teachers και non-editing teachers, και οποιοσδήποτε άλλος 

χρήστης με capability report/outline:view, από Administration > Course 

administration > Reports > Activity report. Τα Activity reports στη κύρια σελίδα του 

Moodle είναι διαθέσιμα για τους administrators και managers από Administration > 

Front page settings > Reports > Activity reports. 
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4.4.5 Πρόσβαση σε επισκέπτες 

 

Έχοντας ενεργή αυτή τη ρύθμιση δίνετε τη δυνατότητα σε χρήστες να 

συνδεθούν στο course ως επισκέπτες- guest. Επίσης μπορείτε να καθορίσετε και 

κωδικό πρόσβασης για αυτούς του χρήστες. 

4.4.6 Groups 

 

4.4.6.1 Group mode 

Στη συγκεκριμένη ρύθμιση μπορείτε να επιλέξετε αν θα έχετε groups ή όχι 

για το course. Οι επιλογές είναι τρεις: “No groups”, “Separate groups”, “Visible 

groups”. Ο τύπος του group που θα επιλέξετε ορίζεται σε επίπεδο course και για 

όλες τις δραστηριότητες αυτού. Για κάθε δραστηριότητα σε ένα course μπορεί να 

οριστεί και ένα group ή διαφορετικό group. Ωστόσο αν για το course έχει οριστεί 

Forced group mode τότε για την κάθε δραστηριότητα τα groups αγνοούνται. 

4.4.6.2 Force group mode 

Αν σε αυτή τη ρύθμιση θέσετε “Yes” τότε τα groups θα ισχύουν σε επίπεδο 

course. Οπότε για οποιαδήποτε δραστηριότητα του εν λόγω course έχετε 

δημιουργήσει groups αυτά θα αγνοούνται. 

4.4.6.3 Default grouping 

Αν έχετε ενεργοποιήσει τα Groupings τότε μπορείτε να τα καθορίσετε. 
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4.4.7 Μετονομασία των ρόλων 

 

Η ρύθμιση αυτή σας επιτρέπει να αλλάξετε τα όνομα των ρόλων για το 

course αυτό. Τα δικαιώματα των χρηστών δεν επηρεάζονται από την αλλαγή των 

ονομάτων. Ο administrator ή ο manager μπορούν να αλλάξουν τα ονόματα. 

4.4.8 Preventing teachers from editing course settings 

Για να εμποδίσετε τους καθηγητές να μπορούν να επεξεργαστούν τα πεδία 

“Course full name, short name, ID number, category, summary” πηγαίνετε: 

1. Site administration > Users > Permissions > Define roles. 

2. Πατήστε το εικονίδιο για την επεξεργασία του ρόλου Teacher. 

3. Αλλάξτε όλα ή καποια capabilities moodle/course:changefullname, 

moodle/course:changeshortname, moodle/course:changeidnumber, 

moodle/course:changecategory, moodle/course:changesummary. 

4. Πατήστε στο τέλος της σελίδας “Save changes”. 
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ΕΠΙΛΟΓΟΣ 

Το κεφάλαιο αυτό εισάγει το χρήστη στη έννοια του course. Τα courses είναι 

τα μαθήματα που συμμετέχουν οι μαθητές σε ένα Moodle site και μπορούν να τα 

δημιουργήσουν είτε ο administrator είτε καθηγητές. Δίνονται αναλυτικές οδηγίες για 

τη δημιουργία, διαγραφή αλλά και τη διαχείρισή τους. Αυτά μπορούν να ανήκουν 

σε κατηγορίες για τις οποίες επίσης δίνονται αναλυτικές οδηγίες για το πώς 

δημιουργούνται και σε τι εξυπηρετούν. Με τη δημιουργία ενός course πρέπει ο 

χρήστης να δώσει ένα όνομα, μια περιγραφή, να επιλέξει τον τρόπο εμφάνισης του 

course στο Moodle site. Επίσης πρέπει να επιλέξει και το course format, δηλαδή 

αν το μάθημα θα είναι σε εβδομαδιαία μορφή, σε ενότητες ή σαν ένα forum. Τέλος 

ο χρήστης μπορεί να επιλέξει τα groups που θα συμμετέχουν στο course. 
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ΚΕΦΑΛΑΙΟ 5 

Groups 
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ΕΙΣΑΓΩΓΗ 

Για να διαχωρίσετε τους συμμετέχοντες σε ένα course δεν έχετε παρά να 

χρησιμοποιήσετε τα Groups του Moodle. Αν είστε καθηγητής σε ένα course 

μπορείτε να διαχωρίσετε τους συμμετέχοντες σε τμήματα – classes ώστε να 

βλέπετε τις δραστηριότητες και το βαθμολόγιο - gradebook για κάθε τμήμα – class. 

Αν είστε καθηγητής και μοιράζεστε ένα course με άλλους καθηγητές και θέλετε να 

βλέπετε τις δραστηριότητες και το βαθμολόγιο - gradebook, χρησιμοποιώντας τα 

Groups δεν θα μπορείτε να διαχειριστείτε και να δείτε τις δραστηριότητες των 

μαθητών των άλλων καθηγητών. Αν θέλετε να ορίσετε μια συγκεκριμένη 

δραστηριότητα, κάποιον πόρο ή κάποιο θέμα σε ένα μόνο τμήμα – class χωρίς να 

μπορούν να το δουν οι υπόλοιποι μπορείτε να χρησιμοποιήσετε τα Groups. 

5.1 Group levels 

Τα Groups ή Grοuping μπορεί να χρησιμοποιηθούν σε δύο επίπεδα: 

• Course level – η λειτουργία του Group ορίζεται σε επίπεδο 

μαθήματος και είναι προεπιλεγμένη λειτουργία για όλες τις 

δραστηριότητες που ορίζονται στο εν λόγω μάθημα. Για να θέσετε τις 

ρυθμίσεις για Groups: Administration > Course administration > Edit 

settings. 

• Activity level – για κάθε Group μπορεί να ορίζεται και διαφορετική 

δραστηριότητα. Αν στις ρυθμίσεις του μαθήματος στο “Forced group 

mode” έχετε επιλεγμένο “Yes” τότε η επιλογή για να ορίσετε τη 

λειτουργία του Group για μεμονωμένη δραστηριότητα δεν είναι 

διαθέσιμη. Αν έχετε επιλέξει “No” τότε ο καθηγητής μπορεί να 

αλλάξει τη λειτουργία του Group. 

•  
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5.2 Group modes 

Για την λειτουργία των Group υπάρχουν 3 επιλογές: 

 No groups – δεν υπάρχουν sub-groups, όλοι οι συμμετέχοντες ανήκουν σε 

μία ομάδα. 

 Separate groups – τα μέλη ενός group μπορούν να βλέπουν μόνο τις 

δραστηριότητες του δικού τους group. Όλα τα άλλα group δεν είναι ορατά 

σε αυτούς. 

 Visible groups - κάθε group συμμετέχει ενεργά στο δικό του group αλλά 

μπορεί να βλέπει και τα άλλα group χωρίς όμως να έχει κάποια άλλη 

δυνατότητα. 

Η χρήση των groups σε forum δίνει τη δυνατότητα στους καθηγητές να 

περιορίσουν την αλληλεπίδραση μεταξύ των μαθητών. Η χρήση των “Separate 

groups” επιβάλει ότι μόνο μαθητές του ίδιου group μπορούν να δουν και να 

συμμετάσχουν σε συζητήσεις του δικού τους forum. Η χρήση των “Visible groups” 

επιτρέπει στους μαθητές να δουν τις συζητήσεις των άλλων groups αλλά να 

συμμετάσχουν μόνο στις συζητήσεις του δικού τους group. 

5.3 Δημιουργία group 

1. Πατήστε “Create group” από: Administration > Course administration 

> Users > Groups. 

2. Δώστε ένα όνομα και μια περιγραφή για το group. Δώστε enrolment 

key και μια φωτογραφία τα οποία θα εμφανίζονται στη σελίδα με 

τους συμμετέχοντες και στις δημοσιεύσεις του forum. 

3. Πατήστε “Save changes”. 

4. Επιλέξτε ένα group και πατήστε “Add/remove users”. 

5. Από τη λίστα “Potential members” επιλέξτε αυτούς τους χρήστες που 

θέλετε να συμμετέχουν στο group. 

6. Πατήστε “Add” για να προσθέσετε μέλη στο group. 

Μπορείτε να δώσετε “ID number” σε κάθε group το οποίο θα είναι 

μοναδικό για κάθε group του μαθήματος. Το “ID number” δεν 

εμφανίζεται οπουδήποτε μέσα στο site. Αυτός ο μοναδικό αριθμός 

μπορεί να προστεθεί ώστε να αντιστοιχίζεται με τα groups σε εξωτερικά 

συστήματα. 

5.4 Αυτόματη δημιουργία group 

Τα groups μπορείτε να τα δημιουργήσετε και αυτόματα πατώντας 

“Autocreate groups” από: Administration > Course administration > Users > 

Groups. Για να εμφανίσετε όλες τις ρυθμίσεις πατήστε το σύνδεσμο επάνω και δεξιά 

“Expand all”. 
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5.5 Εισαγωγή group 

Το Moodle σας δίνει τη δυνατότητα να εισάγεται πολύ εύκολα groups από 

αρχείο. Η μορφή στην οποία πρέπει να είναι το αρχείο αυτό είναι CSV. Το αρχείο 

αυτό απαιτεί ένα υποχρεωτικό πεδίο για τη δημιουργία του και είναι το όνομα του 

group – groupname. Μπορεί να συμπεριλάβει και επιπρόσθετα πεδία. 

• Κάθε γραμμή του αρχείου απαιτεί και μία εγγραφή. 

• Οι εγγραφές πρέπει να διαχωρίζονται με κόμμα. 

• Η πρώτη εγγραφή πρέπει να είναι το groupname. 

Παρακάτω δίνετε ένα παράδειγμα: 

groupname,description,groupidnumber,enrolmentkey 

Team 1,Group Assignment Team 1,team1,orange 

Team 2,Group Assignment Team 2,team2,purple 

Team 3,Group Assignment Team 3,team3,green 
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Για να εισάγετε ένα αρχείο: 

• Από Administration > Course administration > Users > Groups 

πατήστε “Import groups”. 

• Κάντε upload το αρχείο είτε με drag and drop είτε πατώντας “choose 

file”. 

• Πατήστε “Import groups”. 

 

Για να συμπεριλάβετε στο αρχείο και groupingname, τότε θα πρέπει να 

ακολουθήσετε τους παρακάτω κανόνες για τη σύνταξη του αρχείου: 

• Ανάμεσα στο κόμμα και στο κείμενο δεν μπορούν να υπάρχουν 

κενά. • Τα κόμματα ανάμεσα στα δεδομένα πρέπει να 

κωδικοποιηθούν με &#44 – το script θα τα μετατρέψει αυτόματα σε 

κόμμα. 

• Πεδία που περιέχουν Boolean τιμές θα πρέπει για false να βάλετε 0 

και για true 1. 

• Το idnumber ή το coursename μπορούν να χρησιμοποιηθούν για τον 

καθορισμό ενός μαθήματος. Το idnumber υπερισχύει του 

coursename. Αν δεν έχει καθοριστεί τότε τα groups θα προστεθούν 

στο τρέχον course. 

• Το coursename είναι μια συντομογραφία του course. 

• Τα Group id numbers χρησιμεύουν για να ταιριάζουν τα groups σε 

εξωτερικά συστήματα. Σε ένα course τα ID numbers των groups 

πρέπει να είναι μοναδικά. 

• Το αρχείο θα πρέπει να είναι σε ANSI encoding, ή τουλάχιστον να 

μην έχει αποθηκευτεί σε UTF-8 encoding. 

Σημείωση: αν ένα group έχει καταχωρηθεί στη βάση δεδομένων του 

Moodle για ένα συγκεκριμένο course, το script θα επιστρέψει το όνομα 

του group. Στους καθηγητές επιτρέπεται να ανεβάσουν αρχεία μόνο για 

τα group για τα οποία έχουν δικαιώματα. 
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5.6 Groupings 

Αν θέλετε να εντάξετε μία δραστηριότητα για ένα course, όπως για 

παράδειγμα ένα κουίζ, και σε αυτό να πάρουν μέρος ορισμένα μέλη που είναι 

εγγεγραμμένοι στο εν λόγω course θα πρέπει πρώτα να δημιουργήσετε group για 

τους χρήστες και μετά grouping για τους συμμετέχοντες στη νέα δραστηριότητα. 

Με το grouping δηλαδή δημιουργείτε υπό-ομάδες. 

Για να δημιουργήσετε groupings θα πρέπει ο administrator από: 

Administration > Site administration > Development > Experimental να θέσει 

ενεργό το “Enable group members only”. Έπειτα στην δημιουργία της 

δραστηριότητας επεκτείνετε το ”Common module settings”. Στο group mode 

επιλέξτε separate ή visible groups. Επιλέξτε το grouping από το drop down μενού 

και επιλέξτε “Available for group members only”. Τέλος πατήστε “Save changes”. 

5.6.1 Δημιουργία grouping 

Για να δημιουργήσετε grouping: 

• Στο course πηγαίνετε: Settings > Course administration > Users > 

Groups. 

• Και πηγαίντε στην καρτέλα “Groupings”. 

 

• Πατήστε “Creating grouping” 

Μπορείτε να δώσετε ένα “ID number” για το grouping το οποίο θα 

είναι μοναδικό για κάθε course και θα χρησιμοποιείται για να ταιριάζει με 

εξωτερικά συστήματα. Αυτό το “ID number” δεν θα εμφανίζεται πουθενά 

μέσα στο Moodle site. 
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• Πατήστε “Show groups in grouping” για να επεξεργαστείτε τη λίστα 

των χρηστών του grouping. 

 

• Από την λίστα Potential members προσθέστε τα groups στη λίστα 

Existing members. 

 

• Πατήστε “Back to groupings” για να εππιστρέψετε. 

5.6.2 Καθορίστε “default grouping” 

Έχοντας δημιουργήσει grouping, μπορείτε να ορίσετε “Default grouping” για 

το course σας. 

• Στις ρυθμίσεις του administration block 

• Επιλέξτε το default grouping από τις ρυθμίσεις για τα groups. 

5.6.3 Επιλογή grouping για μια δραστηριότητα 

Για να χρησιμοποιήσετε ξεχωριστά grouping για μια δραστηριότητα: 

• Πατήστε “edit settings” για την δραστηριότητα (π.χ. σε ένα forum), και 

από το Common module settings πατήστε το κουμπί “Show 

advanced”. 

• Στο Group mode πρέπει να έχετε θέσει για ρύθμιση είτε “Separate 

groups” είτε “Visible groups”. 

• Επιλέξτε το grouping από το dropdown μενού. 

• Πατήστε “Save settings” στο τέλος της σελίδας. 

Οι μαθητές μπορούν να δουν μόνο τις δραστηριότητες στις οποίες 

συμμετέχουν. Στους καθηγητές εμφανίζεται το όνομα του grouping μέσα σε 

παρενθέσεις μετά το από το όνομα της δραστηριότητας στη σελίδα του 

course. 
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ΕΠΙΛΟΓΟΣ 

Οι καθηγητές και ο administrator ενός Moodle site μπορούν να 

δημιουργήσουν ομάδες χρηστών για τα μαθήματα. Τα groups χρησιμοποιούνται 

σε επίπεδο course αλλά και για διαφορετικές δραστηριότητες. Επίσης ένας 

χρήστης, με τον κατάλληλο ρόλο, που δημιουργεί ένα μάθημα μπορεί να καθορίσει 

από τις ρυθμίσεις αν θα υπάρχουν ή όχι groups για αυτό το course. Αν υπάρχουν, 

διαχωρίζονται σε δύο κατηγορίες. Σε αυτά που οι συμμετέχοντες μπορούν να 

παρακολουθούν και τα άλλα groups, Visible group mode, και σε αυτά που 

παρακολουθούν μόνο τις δραστηριότητες του δικού τους group, Separate group 

mode. Τα group μπορούν να δημιουργηθούν και αυτόματα αλλά μπορούν και να 

εισαχθούν στο Moodle με αρχείο. Τέλος παρέχεται και η δυνατότητα των 

groupings δηλαδή η δημιουργία υπό-ομάδων για ένα group σε περίπτωση που 

θέλετε να διαχωρίσετε τα μέλη μιας ομάδας.  
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ΚΕΦΑΛΑΙΟ 6 

Forum module  
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ΕΙΣΑΓΩΓΗ 

Το forum μπορεί να χρησιμοποιηθεί για πολλούς εκπαιδευτικούς σκοπούς 

και αναμφισβήτητα το forum των φοιτητών αποτελεί μία ξεχωριστή διαδικασία 

επικοινωνίας. Είναι ένας τρόπος με τον οποίο καθηγητές και μαθητές 

ανταλλάσσουν απόψεις και γενικά κάνουν συζητήσεις σε διάφορα θέματα που 

τους απασχολούν. Στο Moodle υπάρχουν 5 τύποι forum. Τα posts των χρηστών 

αξιολογούνται από τους καθηγητές αλλά και από τους μαθητές. 

 

Δημιουργώντας το forum εμφανίζονται αυτόματα οι γενικές ρυθμίσεις που 

μπορείτε να κάνετε. Πρέπει να δώσετε ονομασία και περιγραφή του forum. Τα 

πεδία αυτά είναι απαραίτητα. Παρακάτω μπορείτε να ενεργοποιήσετε τη λειτουργία 

“Display description on course page”, με την οποία θα εμφανίζεται η περιγραφή 

του forum στο course page. 

6.1 Ρυθμίσεις για το forum 

Για να δημιουργήσετε νέο forum πρώτα θα πρέπει από το Administration 

μενού να κάνετε Turn editing on. 

 Αν θέλετε να δημιουργήσετε forum στο homepage τότε είτε στο κύριο μενού 

πατάτε “Add an activity or resource” και επιλέγετε “Forum” από το μενού 

που εμφανίζεται, είτε στη μέση και στα δεξιά του homepage πατώντας “Add 

and activity or resource” και επιλέγετε από το μενού Forum. 

 Αν θέλετε να δημιουργήσετε forum για ένα συγκεκριμένο course τότε 

επιλέγετε το course και δημιουργείτε με τον παραπάνω τρόπο το forum στη 

δραστηριότητα που επιθυμείτε. 

 Για να κάνετε ρυθμίσεις για το forum μπορείτε από το εικονίδιο Edit > Edit 

settings ή από Administration > Forum administration > Edit settings. 
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6.1.1 Γενικές ρυθμίσεις 

Στα πεδία “Forum name” και “Description”, τα οποία είναι υποχρεωτικά, 

δίνετε ένα όνομα και μια περιγραφή για το forum που δημιουργείτε. Παρακάτω 

μπορείτε να επιλέξετε αν η περιγραφή θα εμφανίζεται στη σελίδα του course 

“Display description on course page”. Στην τελευταία επιλογή (αναλύεται 

παρακάτω) επιλέγεται τον τύπο του forum που θα χρησιμοποιήσετε. 

6.1.2 Τύποι forum 

Υπάρχουν πέντε τύποι forum από τους οποίους μπορείτε να επιλέξετε: 

• A single simple discussion – χρησιμοποιείται κυρίως για σύντομες 

συζητήσεις (δεν μπορεί να χρησιμοποιηθεί για ξεχωριστά group χρηστών). 

 
• Standard forum for general use – οποιοσδήποτε χρήστης μπορεί να θέσει 

θέμα για συζήτηση οποιαδήποτε στιγμή. Αποτελεί καλή επιλογή για forum 

γενικού σκοπού. 

 

• Each person posts one discussion – κάθε χρήστης μπορεί δημοσιεύσει ένα 

ακριβώς θέμα για συζήτηση (καθένας μπορεί να απαντήσει σε αυτό). 
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Χρησιμοποιείται κυρίως όταν θέλετε ο κάθε μαθητής να ξεκινήσει ένα θέμα 

συζήτησης και οι υπόλοιποι να ανταποκριθούν σε αυτό. 

 

• Q and A forum – ο καθηγητής δημοσιεύει μία ερώτηση στην οποία οι 

μαθητές μπορούν να απαντήσουν. Ο κάθε μαθητής δεν μπορεί να δει τη 

συζήτηση αν δεν έχει απαντήσει στην ερώτηση δηλαδή αν δεν συμμετέχει 

ενεργά στη συζήτηση για την συγκεκριμένη ερώτηση που έχει τεθεί. 

 

• Standard forum displayed in a blog-like format – αποτελεί ένα ανοιχτό 

forum, έχει τα χαρακτηριστικά του τύπου Standard forum for general use, 

όπου ο κάθε χρήστης μπορεί να ξεκινήσει μία συζήτηση. Η πρώτη 

δημοσίευση του χρήστη εμφανίζεται σαν σε blog και οι υπόλοιποι χρήστες 

μπορούν να συμμετάσχουν στη συζήτηση πατώντας το button «Discuss 

this topic» κάτω και δεξιά από τη δημοσίευση. 

Σημείωση: το News forum είναι ένας ειδικός τύπος forum για το Moodle που 

δημιουργείτε αυτόματα με τη δημιουργία ενός course. 
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6.1.3 News forum 

Το News forum είναι ένα ειδικό forum για γενικές ανακοινώσεις. Με τη 

δημιουργία ενός course δημιουργείται αυτόματα το forum αυτό στην κύρια σελίδα 

του Moodle site. Στο forum αυτό συμμετέχουν, εξ ορισμού, οι καθηγητές και οι 

administrators του Moodle site. Στο “Latest news block” εμφανίζεται ο αριθμός των 

πρόσφατων δημοσιεύσεων στο forum. 

 

Για να διαγράψετε το News forum: 

1. Διαγράψτε το “News forum” από το homepage του course. 

2. Στο “Course settings” θέστε στο “News items to show” σε 0 (μηδέν). 

3. Διαγράψτε το “Latest news block”. 

4. Εναλλακτικά – κάντε “hide” το News forum. 

6.2 Συνημμένα και καταμέτρηση λέξεων 

Με αυτές τις ρυθμίσεις ο χρήστης μπορεί να καθορίσει το μέγεθος των αρχείων 

που μπορούν οι χρήστες να επισυνάπτουν στο forum καθώς και τον αριθμό των 

αρχείων που μπορούν να επισυνάψουν. Επίσης με την τελευταία ρύθμιση γίνεται 

καταμέτρηση των λέξεων που γράφει κάθε χρήστης σε μία δημοσίευση. 
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6.2.1 Μέγιστο μέγεθος για συνημμένα 

Το μέγιστο μέγεθος αρχείου που μπορεί να επισυναφθεί καθορίζεται από 

τις ρυθμίσεις του Moodle site. Ο καθηγητής του μαθήματος όμως έχει τη 

δυνατότητα να καθορίσει κάποιο άλλο μέγεθος για τα αρχεία που θα κάνουν 

upload οι μαθητές για το εν λόγω μάθημα. Μερικοί λόγοι που περιορίζουν το 

μέγεθος των αρχείων είναι κυρίως η χωρητικότητα του server, η ταχύτητα με την 

οποία θα κάνουν download τα αρχεία οι μαθητές, το μέγεθος των εικόνων που 

επισυνάπτονται σε κάποια δημοσίευση. 

6.2.2 Μέγιστος αριθμός συνημμένων 

Σε αυτό το πεδίο καθορίζεται ο αριθμός των αρχείων που μπορούν να 

επισυναφθούν. 

6.2.3 Εμφάνιση καταμέτρησης λέξεων 

Αν αυτό το πεδίο είναι ενεργοποιημένο τότε θα εμφανίζεται ο αριθμός των 

λέξεων για κάθε δημοσίευση. 

6.3 Subscription and Tracking 

Όταν ένας χρήστης είναι εγγεγραμμένος σε ένα forum για κάθε νέο δημοσίευμα 

λαμβάνει ειδοποίηση είτε μέσω pop up ή/και μέσω email. Εξ ορισμού κάθε 

δημοσίευση καταγράφεται στο forum μετά από 30 λεπτά. Οι χρήστες μπορούν να 

επιλέξουν για το αν θα συμμετάσχουν-εγγραφούν στο εκάστοτε forum. Ωστόσο ο 

καθηγητής επιλέγοντας “Forced subscription” οι συμμετέχοντες στο course 

εγγράφονται αυτόματα στο forum. Οι χρήστες που θα εγγραφούν σε 

μεταγενέστερο χρόνο στο course εγγράφονται και αυτοί αυτόματα στο forum. 

Ο καθηγητής μπορεί να επιλέξει έναν από τους 4 παρακάτω τρόπους 

εγγραφής στο forum: 

 Optional subscription – οι χρήστες μπορούν να επιλέξουν για τη συμμετοχή 

τους στο forum. 

 Forced subscription – συμμετέχουν όλοι οι χρήστες στο forum και δε 

μπορούν να διαγραφούν από αυτό. 

 Auto subscription – μπορεί να εγγραφεί οποιοσδήποτε στο forum και να 

διαγραφεί οποιαδήποτε στιγμή το επιθυμεί. 

 Subscription disabled – δεν επιτρέπεται η εγγραφή στο forum. 
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6.3.1 Read tracking for this forum? 

Η επιλογή “Read tracking” για ένα forum επιτρέπει στους χρήστες να 

παρακολουθούν αναγνωσμένες και μη αναγνωσμένες δημοσιεύσεις. 

Υπάρχουν 3 επιλογές: 

 Optional – οι χρήστες μπορούν να ενεργοποιήσουν ή να 

απενεργοποιήσουν αυτή την ρύθμιση από Administration > Forum 

administration επιλέγοντας “Track / Don’t track unread posts” ή από 

το προφίλ επιλέγοντας “Forum tracking”. 

 Off – δεν μπορούν να εντοπιστούν μη αναγνωσμένες δημοσιεύσεις. 

 Forced – το “tracking” είναι ενεργοποιημένο για αυτό το forum, 

ανεξάρτητα από τις ρυθμίσεις του χρήστη. Δεν εμφανίζεται στο menu 

το Administration > Forum administration. Αυτή η ρύθμιση 

εμφανίζεται όταν ο administrator θέσει ενεργή την επιλογή “Allow 

forced read tracking”. 
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6.4Post threshold for blocking 

6.4.1 Time period for blocking 

Η ρύθμιση αυτή μπλοκάρει τους μαθητές οι οποίοι σε συγκεκριμένο χρονικό 

διάστημα ξεπερνούν συγκεκριμένο αριθμό δημοσιεύσεων. Οι χρήστες με capability 

mod/forum:postwithoutthrottling εξαιρούνται από αυτό τον περιορισμό. 

6.4.2 Post threshold for blocking 

Η ρύθμιση αυτή καθορίζει τον μέγιστο αριθμό δημοσιεύσεων που μπορεί ο 

χρήστης να δημοσιεύσει στο forum σε συγκεκριμένο χρονικό διάστημα. 

6.4.3 Post threshold warning 

Η ρύθμιση αυτή καθορίζει μετά από πόσες δημοσιεύσεις ο χρήστης θα 

λάβει προειδοποίηση ότι πλησιάζει τον μέγιστο αριθμό δημοσιεύσεων. 

6.5 Κατηγορίες για βαθμολόγηση 

Στο πεδίο αυτό καθορίζεται την κατηγορία βαθμολογίας με την οποία 
αξιολογούνται οι δραστηριότητες στο βαθμολόγιο. 
 

6.6Αξιολογήσεις 

6.6.1 Δικαιώματα για αξιολογήσεις 

Οι δημοσιεύσεις στο forum μπορούν να αξιολογηθούν με κλίμακα. Εξ 

ορισμού μόνο οι καθηγητές μπορούν να αξιολογήσουν τις δημοσιεύσεις, ωστόσο 

όμως αν το επιθυμείτε μπορείτε να δώσετε και στους μαθητές δικαιώματα για 

αξιολόγηση των δημοσιεύσεων. Όλες οι αξιολογήσεις του forum καταγράφονται 

στο gradebook. 
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6.6.2 Aggregate type 

Η ρύθμιση “Aggregated type” καθορίζει πως θα συνδυάζονται οι 

βαθμολογίες για να σχηματιστεί ο τελικός βαθμός του μαθητή στο gradebook. 

 Average of ratings – μέση τιμή όλων των αξιολογήσεων. 

 Count of ratings – το πλήθος των αξιολογήσεων γίνεται ο τελικός βαθμός. 

Σημείωση: το συνολικό ποσό δεν μπορεί να υπερβαίνει το μέγιστο βαθμό 

(maximum grade) για την δραστηριότητα. 

 Maximum – η υψηλότερη βαθμολογία. 

 Minimum – η χαμηλότερη βαθμολογία. 

 Sum – άθροισμα των αξιολογήσεων. Σημείωση: το συνολικό ποσό δεν 

μπορεί να υπερβαίνει το μέγιστο βαθμό (maximum grade) για την 

δραστηριότητα. 

Σημείωση: αν έχετε επιλέξει να μην υπάρχουν αξιολογήσεις για αυτή τη 

δραστηριότητα, οι αξιολογήσεις δεν θα εμφανίζονται στο gradebook 

6.6.3 Περιορισμός αξιολογήσεων 

Με τη ρύθμιση αυτή ο καθηγητής μπορεί να καθορίσει το χρονικό διάστημα 

μέσα στο οποίο οι μαθητές μπορούν να αξιολογήσουν τις δημοσιεύσεις. 

 
6.7Common module settings 
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6.7.1 Visible 

Επιλέξτε αν θέλετε να είστε ορατοί ή όχι όταν συμμετέχετε στο forum. 

6.7.2 ID number 

Καθορίστε στο πεδίο ένα “ID number” το οποίο θα είναι μοναδικό και 

χρήσιμο για τις διαδικασίες της αξιολόγησης. 

6.7.3 Group mode 

Για το “Group mode” έχετε 3 επιλογές: 

1. No groups 

2. Separate groups – κάθε ομάδα μπορεί να βλέπει μόνο τη δική της 

ομάδα χρηστών, κάθε άλλη ομάδα δεν είναι ορατή. 

3. Visible group – κάθε ομάδα συνεργάζεται με τη δική της ομάδα αλλά 

μπορεί να βλέπει και άλλες ομάδες. 

 

Αν στο “Group mode” επιλέξετε “Separate groups” τότε: 

 Ο καθηγητής μπορεί να δώσει την επιλογή να προσθέσουν 

μία δημοσίευση είτε όλοι οι συμμετέχοντες είτε κάποια ομάδα 

αυτών. Αν ο καθηγητής προσθέσει μια δημοσίευση σε μια 

ομάδα τότε μόνο τα μέλη αυτής μπορούν να συμμετάσχουν. 

Αν ο καθηγητής προσθέσει μία δημοσίευση για όλους τους 

συμμετέχοντες τότε οι μαθητές δεν μπορούν να συμμετέχουν. 

 Οι μαθητές μπορούν να δημοσιεύσουν ένα θέμα στο forum 

για την ομάδα στην οποία συμμετέχουν. 

 Οι μαθητές μπορούν να απαντήσουν μόνο σε δημοσίευση η 

οποία έχει προστεθεί από μέλη της ομάδας τους ή σε 

δημοσίευση που προστέθηκε για την δική τους ομάδα από 

καθηγητή. 
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Αν στο “Group mode” επιλέξετε “Visible groups” τότε: 

 Ο καθηγητής μπορεί να δώσει την επιλογή να προσθέσουν 

μία δημοσίευση είτε όλοι οι συμμετέχοντες είτε κάποια ομάδα 

αυτών.  

 Οι μαθητές μπορούν να προσθέσουν δημοσίευση για τη δική 

τους ομάδα. 

 Οι μαθητές μπορούν να απαντήσουν σε δημοσίευση που 

προστέθηκε από μέλη της δικής τους ομάδας ή από τον 

καθηγητή. 

Οι χρήστες με capability moodle/site:accessallgroups μπορούν να δουν και 

να προσθέσουν δημοσιεύσεις σε οποιαδήποτε ομάδα του forum ανεξάρτητα από 

τις ρυθμίσεις που έχουν οριστεί για κάθε ομάδα. 

Σημείωση: η επιλογή forum τύπου “Single simple discussion” δεν 

μπορεί να οριστεί για ομάδες χρηστών. Αντ’ αυτού χρησιμοποιείται ο τύπος forum 

“Standard forum” όπου ο καθηγητής μπορεί να προσθέτει την ίδια δημοσίευση για 

κάθε ομάδα χρηστών. Αν είναι απαραίτητο οι μαθητές να μη μπορούν να 

προσθέσουν δημοσιεύσεις θα πρέπει να οριστούν και τα κατάλληλα capabilities. 

6.8 Locally assigned roles 

Για να δώσετε επιπρόσθετους ρόλους σε χρήστες του forum επιλέξτε από 

Administration > Forum administration > Locally assigned roles. 

6.8.1 Forum moderator 

Σε ένα forum έχετε τη δυνατότητα να δώσετε σε χρήστη το ρόλο του 

moderator. Ο χρήστης με αυτό το ρόλο έχει τη δυνατότητα να επεξεργαστεί και να 

διαγράψει δημοσιεύσεις και να μεταφέρει δημοσιεύσεις σε άλλο forum. Αυτός ο 

ρόλος είναι χρήσιμος όταν θέλετε ένας μαθητής να συντονίζει το forum αλλά να 

μην έχει τη δυνατότητα επεξεργασίας των ρυθμίσεων του course. Για να δώσετε 

σε χρήστη το ρόλο του moderator για ένα forum θα πρέπει να του αναθέσετε το 

ρόλο “non-editing teacher” ως ακολούθως: 

1. Είσοδος στο forum ως καθηγητής. 

2. Από το Administration block του forum επιλέξτε “Locally assigned roles” και 

αναθέστε το ρόλο “non-editing teacher” στο χρήστη ή τους χρήστες που 

θέλετε. 
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6.9 Δικαιώματα για το forum 

Τα δικαιώματα για κάθε ρόλο στο forum μπορούν να αλλάξουν από: 

Administration > Forum administration > Permissions. Aλλαγές στα κοινά 

δικαιώματα μπορεί να είναι: 

 Enabling students to rate posts (allow): επιτρέπεται ο μαθητής να αξιολογεί 

δημοσιεύσεις. 

6.9.1 Archiving a forum 

Ένα forum μπορεί να κλείσει / αρχειοθετηθεί έτσι ώστε οι μαθητές να μην 

μπορούν να προσθέσουν κάποια δημοσίευση ή να απαντήσουν σε κάποια από 

αυτές επιλέγοντας (X) στο “Prevent icon” για τα δικαιώματα “Start new discussion” 

και “Reply to posts”. Μπορούν όμως να διαβάσουν τις δημοσιεύσεις. 

6.9.2 Επισκέπτες για το forum 

Υπάρχουν ορισμένα πράγματα, όπως οι δημοσιεύσεις σε forum, που οι 

επισκέπτες δεν μπορούν να κάνουν παρ’ ότι το interface του Moodle τους δίνει τα 

δικαιώματα. Ένας επισκέπτης σε forum, χρήστης με guest role, αν θα 

προσπαθήσει να κάνει δημοσίευση σε forum θα λάβει το μήνυμα:”Sorry, guests 

are not allowed to posts. Would you like to log in now with a full user account?”. 
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Σημείωση: αν επισκέπτης στο forum δεν λάβει το μήνυμα” Sorry, guests 

are not allowed to posts” θα πρέπει να ενεργοποιήσετε την επιλογή “Self 

enrolment” από: Settings > Course administration > Users > Enrolment methods. 

Αν θέλετε οι χρήστες με guest role να μπορούν να κάνουν δημοσίευση στο 

forum θα πρέπει να δώσετε σε αυτούς τους χρήστες το ρόλο “Forum poster role”. 

6.9.2.1 Forum poster role 

Τα δικαιώματα για τα ρόλο αυτό είναι εξαιρετικά περιορισμένα και όταν 

δοθεί ο ρόλος αυτός σε κάποιο χρήστη θα μπορεί να δημοσιεύσει στο forum ως 

επισκέπτης. Ο ρόλος αυτός αποτελεί μία λύση για course το οποίο το έχετε 

ανοιχτό για επισκέπτες και θέλετε να επιτρέψετε στους χρήστες με guest role να 

συμμετέχουν στις δημοσιεύσεις. 

6.9.2.1.1 Δημιουργία νέου ρόλου 

Αρχικά θα πρέπει να δημιουργήσετε ένα λογαριασμό για επισκέπτες, για 

παράδειγμα: username=visitor και password=visitor(εναλλακτικά το password θα 

πρέπει να ακολουθεί τους περιορισμούς). 

1. Ως administrator από: Site administration > Users > Permissions > Define 

roles και πατήστε "Add a new role". 

2. Στην επόμενη σελίδα αγνοείστε τις προεπιλογές και πατήστε “Continue”. 

3. Δώστε όνομα στο ρόλο και αν θέλετε και περιγραφή και επιλέξτε “System” 

και “Course”. 

 

4. Πατήστε “Show advanced”. 

5. Στο πεδίο “Filter” κάντε αναζήτηση το “forum” και επιλέξτε “Allow” για τις 

επιλογές: ”Reply to posts”, “Start new discussions”, “View discussions”. 

6. Στο πεδίο “Filter” κάντε αναζήτηση το “profile” και επιλέξτε “Prohibit” για τις 

επιλογές: “Edit own profile” και “View users profile”. 

7. Στο πεδίο “Filter” κάντε αναζήτηση το “password” και επιλέξτε “Prohibit” για 

την επιλογή: “Change own password”. 
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8. Μπορεί σύμφωνα με τις εκάστοτε ανάγκες να περιορίσετε άλλα δικαιώματα 

όπως για παράδειγμα την αποστολή μηνυμάτων. 

9. Πατήστε “Create this role”. 

 

6.9.2.1.2 Ανάθεση ρόλου σε επισκέπτη 

Τις παρακάτω ρυθμίσεις μπορεί να τις κάνει ΜΟΝΟ ο administrator. 

1. Αν δεν έχετε δημιουργήσει λογαριασμό για τους επισκέπτες: Site administrator 

> Users > Accounts > Add a new user. 

2. Site administration > Users > Permissions > Assign system roles. 

3. Αναθέστε στο χρήστη που θέλετε το ρόλο που έχετε δημιουργήσει νωρίτερα. 

4. Πηγαίνετε στο course στο οποίο θέλετε να συμμετάσχει ο επισκέπτης στο 

forum. 

5. Από: Course administration > Users > Enrolled users επιλέξτε από το μενού το 

ρόλο που έχετε δημιουργήσει και αναθέστε τον στον χρήστη που θέλετε για 

επισκέπτη. 

6.9.2.1.3 Πληροφορίες για τους χρήστες 

1. Αν έχουν δοθεί δικαιώματα σε επισκέπτη για ένα course, θα ήταν καλό στην 

αρχή της σελίδας του course να γράψετε το username και password που θα 

χρησιμοποιούν οι επισκέπτες για να μπορούν να δημοσιεύσουν στο forum. 

2. Επειδή οι δημοσιεύσεις των επισκεπτών εμφανίζονται όλες με το ίδιο 

username, θα μπορούσατε λοιπόν με ένα επεξηγηματικό σημείωμα να τους 

αναφέρεται να προσθέτουν το όνομά τους στη δημοσίευσή τους. 

3. Ο ρόλος του επισκέπτη έχει περιορισμένα δικαιώματα και ορισμένες 

δραστηριότητες όπως Quiz και Wiki δεν θα είναι προσβάσιμες. 
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6.10 User administration settings 

Στο “Forum tracking” εμφανίζονται 2 επιλογές για το αν στους χρήστες θα 

εμφανίζονται οι μη διαβασμένες δημοσιεύσεις του forum. Οι επιλογές αυτές είναι: 

• Yes: highlight new posts for me 

• No: don’t keep track of posts I have seen 

Αν ο χρήστης επιλέξει “Yes: highlight new posts for me” και ο administrator του 

forum έχει την επιλογή “Read tracking for this forum?” σε κατάσταση “On” ή 

“Optional” τότε οι δημοσιεύσεις θα εμφανίζονται στο χρήστη. 

 

Η δημοσίευση θα εμφανίζεται στα εξής σημεία: 

• My home page 

• Course page 

• Forum page 

• In forum discussion threads 

 
6.11 Site administration settings 

Για το forum υπάρχουν και άλλες ρυθμίσεις οι οποίες μπορούν να 

παραμετροποιηθούν από: Administration > Site administration > Plugins > Activity 

modules > Forum. Για να αλλάξετε το “Maximum time to edit posts” πηγαίνετε: 

Administration > Site administration > Security > Site policies. 

6.11.1 Χρήση email για απάντηση 

Εξ ορισμού το email του χρήστη εμφανίζεται σε κάθε δημοσίευση χρήστη, 

εκτός και αν ο χρήστης έχει απενεργοποιήσει την επιλογή αυτή από το προφίλ του, 

έτσι ώστε οι άλλοι χρήστες να μπορούν να απαντήσουν με email στο χρήστη και 

όχι μέσω forum. Για όλες τις ειδοποιήσεις του forum με τη διεύθυνση email του 

κάθε χρήστη επιλέξτε το checkbox για noreply@yourmoodlesite.org. 

6.11.2 Long and short posts 

Οι ρυθμίσεις “long post ” και “short post” καθορίζουν τον τρόπο εμφάνισης 

των δημοσιεύσεων, το social format course pages και την εμφάνιση των προφίλ 

των χρηστών. Σημείωση: προς το παρόν υπάρχει ένα πρόβλημα που δεν έχει 

λυθεί: “Site news – forum length setting has no effect for certain users”. 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

81 από 132 

6.11.3 Enabling time posts 

Η επιλογή αυτή επιτρέπει στους manager, teacher και non-editing teacher 

να καθορίσουν ένα χρονικό διάστημα στο οποίο θα μπορούν οι μαθητές να 

χρησιμοποιούν το forum για δημοσιεύσεις και να μπορούν να δουν δημοσιεύσεις 

οι οποίες είναι κρυμμένες (hidden). Εξ ορισμού αυτή η επιλογή είναι 

απενεργοποιημένη. Για να την ενεργοποιήσετε: Administration > Site 

administration > Plugins > Activity modules > Forum. 

6.11.4 Maximum time to edit posts 

Αυτή η επιλογή καθορίζει το χρονικό διάστημα στο οποίο οι χρήστες 

μπορούν να επεξεργαστούν τις δημοσιεύσεις τους. Συνήθως τα 30 λεπτά είναι μία 

καλή επιλογή. Για να ρυθμίσετε αυτό το διάστημα: Administration > Site 

administration > Security > Site policies. 

6.11.5 Read tracking 

Κατά τη δημιουργία forum μπορείτε να ρυθμίσετε την επιλογή “Read 

tracking”.Οι επιλογές είναι: “Forced” αν θέλετε να είναι ενεργή, “Optional” και “Off”. 

Όταν κατά τη δημιουργία forum για “Read tracking” επιλέξετε “Forced” η 

ρύθμιση αυτή θα είναι σε λειτουργία ανεξάρτητα από τις ρυθμίσεις του Moodle. Οι 

χρήστες που έχουν απενεργοποιημένη αυτή τη ρύθμιση θα μπορούν να 

περιηγηθούν στις course pages πιο εύκολα διότι αυτή η ρύθμιση επιβαρύνει με 

φόρτο τον server. Για προαιρετική λειτουργία επιλέξετε “Optional”. 

6.11.6 Mark posts after ‘X’ days 

H επιλογή “forum_oldpostdays” καθορίζει το χρονικό διάστημα μετά το 

οποίο μία δημοσίευση πρέπει να εμφανίζεται ότι έχει διαβαστεί. Για παράδειγμα 

αν έχετε θέσει αυτό το διάστημα σε 14 μέρες κάθε δημοσίευση που έχει 

τοποθετηθεί στο forum μετά το πέρας των 14 ημερών θα εμφανίζεται ως 

διαβασμένη. Αν θέσετε τη ρύθμιση σε 0 (μηδέν) ημέρες τότε όλες οι δημοσιεύσεις 

θα θεωρούνται διαβασμένες. Αν δεν θέλετε οι δημοσιεύσεις να θεωρείται ότι έχουν 

διαβαστεί από τους χρήστες χωρίς να τις έχουν διαβάσει τότε θα πρέπει να 

δώσετε την ανώτερη τιμή (1000). 

6.11.7 Changing the subject line of forum notifications 

Κανονικά όταν οι συμμετέχοντες του forum λαμβάνουν email από κάποια 

ενέργεια που έγινε στο forum εμφανίζονται στο email και οι παρακάτω 

πληροφορίες: 

Course short name και Subject of post. 
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Το “Subject line” μπορεί να αλλάξει. Για παράδειγμα αν θέλετε να 

εμφανίζονται: Course short name + Forum name + Subject θα πρέπει από: Site 

administration > Language > Language customization και στο forum.php και στο 

string postmailsubject να θέσετε το παρακάτω: 

{$a-

>courseshortname} {$a->forumname} {$a- 

6.12 Χρησιμοποιώντας το forum 

6.12.1 Επιλογές για την προβολή του forum 

Μία συζήτηση στο forum μπορεί να εμφανίζεται με 4 διαφορετικούς τρόπους. 

Μπορείτε να επιλέξετε έναν κάθε φορά από το pull down μενού στην αρχή της 

σελίδας της συζήτησης. 

• Display replies flat, with oldest first 

• Display replies flat, with newest first – οι δημοσιεύσεις εμφανίζονται σε μία 

γραμμή και με χρονολογική σειρά από την πιο πρόσφατη σε 

μεταγενέστερες. 

• Display replies in threaded form – μόνο η πρώτη δημοσίευση εμφανίζεται 

ολόκληρη, για τις απαντήσεις αυτής της δημοσίευσης εμφανίζονται μόνο οι 

επικεφαλίδες, περιλαμβάνοντας πληροφορίες για τον συντάκτη της και την 

ημέρα και ώρα που πραγματοποιήθηκε η δημοσίευση, χρονολογικά 

οργανωμένες. 

• Display replies in nested form – όλες οι δημοσιεύσεις εμφανίζονται 

ολοκληρωμένες, για τις απαντήσεις της κάθε δημοσίευσης εμφανίζονται 

μόνο οι επικεφαλίδες, περιλαμβάνοντας πληροφορίες για τον συντάκτη της 

και την ημέρα και ώρα που πραγματοποιήθηκε η δημοσίευση, χρονολογικά 

οργανωμένες. 

 
Επιλογές εμφάνισης απαντήσεων  

>subject} 
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Εμφάνιση δημοσιεύσεων σε μία γραμμή  

 

Εμφάνιση πρώτης δημοσίευσης  

 

Εμφάνιση ολοκληρωμένων δημοσιεύσεων  
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6.12.2 Forum posting 

Όταν γράφετε κείμενο στο Moodle υπάρχουν διάφορα formats που 

μπορείτε να χρησιμοποιήσετε για το κείμενό σας ανάλογα και με το browser που 

χρησιμοποιείτε. Ο προεπιλεγμένος τρόπος εμφάνισης για την απάντηση σε μια 

δημοσίευση είναι: “Re: <the name of the ‘parent’ post>”, ο οποίος μπορεί να 

αλλάξει. 

6.12.2.1 Διαμοιράστε εικόνες μέσω του forum 

• Για να προσθέσετε μία εικόνα στο forum μπορείτε με τη διαδικασία “drag 

and drop” να κάνετε upload μία εικόνα πατώντας “Add” από το File picker. 

• Όταν μία εικόνα επισυνάπτεται σαν forum message εμφανίζεται αμέσως και 

έτσι μπορείτε να αποφύγετε τη διαδικασία “upload” ως αρχείο και του 

διαμοιρασμού του σε web pages. 

 
6.12.2.2 Διαμοιράστε ήχο και βίντεο μέσω του forum 

• Αν είναι ενεργοποιημένη η επιλογή για τα πολυμέσα, τότε μπορείτε 

να προσθέσετε αρχεία ήχου (σε mp3 μορφή) και αρχεία βίντεο σε 

δημοσιεύσεις του forum. 

• Όπως και με τις εικόνες παραπάνω, αρχεία πολυμέσων μπορούν να 

προστεθούν με τη διαδικασία “drag and drop” αντί να προστεθούν με 

το File picker. 

6.12.2.3 Μέγεθος δημοσίευσης 

Όταν μία δημοσίευση είναι πολύ μεγάλη σε έκταση τότε σε αναζήτησή της 

στο forum ενδέχεται να μην εμφανίζεται ολόκληρη στην οθόνη. Προτείνεται αυτές 

οι δημοσιεύσεις να συντάσσονται σε αρχείο και να επισυνάπτονται στο forum. 
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6.12.2.4 Χρονικό όριο για την επεξεργασία δημοσίευσης 

Υπάρχει ένα χρονικό όριο για την επεξεργασία των δημοσιεύσεων, 

συνήθως 30 λεπτά. Το όριο αυτό μπορεί να παραμετροποιηθεί από τον 

administrator από: Administration > Security > Site policies. Η επιλογή αυτή είναι 

χρήσιμη διότι σε μια συζήτηση στο forum μετά από κάποιο αριθμό απαντήσεων 

που έχουν δημοσιευθεί ο καθηγητής θέλει να διαγράψει κάποια από αυτές διότι τη 

θεωρεί ακατάλληλη ή περιττή για το forum. Η μόνη επιλογή που έχει είναι να 

διαγράψει ολόκληρο το δέντρο της συζήτησης. 

6.12.2.5 Mail now 

Όταν γίνεται μία δημοσίευση στο forum αποστέλλεται άμεσα ειδοποίηση με 

email σε όλους τους συμμετέχοντες στο forum. Για να δείτε τις ειδοποιήσεις 

ελέγξτε το box “Mail now”. Οι ρυθμίσεις για το “Mail now box” μπορούν να γίνουν 

μόνο από τους διαχειριστές του μαθήματος, δηλαδή τον administrator και τους 

καθηγητές. 

6.12.3 Εξαγωγή των δημοσιεύσεων 

Κάθε χρήστης με capability mod/forum:exportdiscussion ή 

mod/forum:exportownpost ή mod/forum:exportpost μπορεί να κάνει export 

δημοσιεύσεις του forum σε χαρτοφυλάκιο που έχει ενεργοποιήσει ο administrator. 

 

6.12.4 Μεταφέρετε τις συζητήσεις 

Οι χρήστες με τα κατάλληλα δικαιώματα, καθηγητές, manager και 

nonediting teacher, μπορούν να μεταφέρουν μία συζήτηση σε άλλο forum του 

course. 

 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

86 από 132 

 Πατήστε το βέλος “Move discussion to… ” και από το drop down menu 

επιλέξτε που θέλετε να μετακινήσετε τη συζήτηση του forum και πατήστε 

“Move”. 

Σημείωση: μεταφέροντας ένα forum σε ένα άλλο θα διαπιστώσετε ότι στο 

“Course participation report” υπάρχουν λανθασμένα αποτελέσματα. Για 

παράδειγμα μία δημοσίευση ενός μαθητή στο forum Α θα έχει μεταφερθεί στο 

forum Β. Ο μαθητής ναι μεν θα αναφέρεται στο “Course participation report” αλλά 

δεν θα πρέπει να αναφέρεται ότι έκανε δημοσίευση στο forum Β. 
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ΕΠΙΛΟΓΟΣ 

Αν αποφασίσετε να χρησιμοποιήσετε ένα forum για συζητήσεις είναι 

σημαντικό να γνωρίζεται κάποια πράγματα εξ αρχής ώστε να ολοκληρώσετε 

σωστά αυτή τη δραστηριότητα. Το Moodle παρέχει 5 διαφορετικούs τύπους forum 

κάθε ένας για διαφορετικό σκοπό και με διαφορετικό layout. Για να επιλέξετε ποιον 

τύπο θα χρησιμοποιήσετε θα πρέπει να σκεφτείτε ποιος τύπος ταιριάζει στις 

ανάγκες της δραστηριότητας που θέλετε να αναπτύξετε μέσω του forum. Οι 

συμμετέχοντες σε forum μπορούν να δημοσιεύουν στο forum αρχεία, εικόνες και 

βίντεο εκτός από τις συζητήσεις. Επίσης μπορούν να συμμετάσχουν χρήστες σαν 

επισκέπτες του forum.  
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ΚΕΦΑΛΑΙΟ 7 

Database activity module  
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ΕΙΣΑΓΩΓΗ 

Μια βάση δεδομένων στο Moodle επιτρέπει στους καθηγητές και τους 

μαθητές να διαχειριστούν σύνολα δεδομένων για οποιοδήποτε θέμα. Τα δεδομένα 

μπορούν να καταχωρηθούν σε διάφορες μορφές όπως εικόνες, αρχεία, URLs, 

κείμενα και άλλα. Μετά τη δημιουργία της βάσης δεδομένων πρέπει να ορίσετε τα 

πεδία – fields που καθορίζουν τις πληροφορίες για τη βάση. Προαιρετικά θα 

μπορούσατε να επεξεργαστείτε και τα πρότυπα – templates για να καθορίσετε ή 

να αλλάξετε τον τρόπο εμφάνισης των δεδομένων. Τα templates στη βάση 

δεδομένων σας επιτρέπουν να ελέγχεται και να διαχειρίζεστε την αναπαράσταση 

των πληροφοριών της βάσης σας, τον τρόπο προβολής των καταχωρήσεων και 

την επεξεργασίας τους. Όλα τα templates στις βάσεις δεδομένων του Moodle 

λειτουργούν με τις ίδιες αρχές. 

7.1 Δημιουργία Βάσης Δεδομένων  

Για τη δημιουργία μιας βάσης δεδομένων: 

 Από το Administration block θέστε “Turn editing on”, και στη δραστηριότητα 

που θέλετε να δημιουργήσετε τη βάση δεδομένων πατήστε ”Add an activity 

or resource” και επιλέξτε από το drop down menu “Database”. 

 Δώστε ένα όνομα και μια περιγραφή για τη βάση δεδομένων. 

 Κάντε τις κατάλληλες ρυθμίσεις. 

 Πατήστε “Save and display” στο τέλος της σελίδας. 

 Καθορίστε τα πεδία ή τα preset. 

 Καθορίστε τα templates. 

 Δημιουργήστε και προσθέστε μερικές εγγραφές στη βάση δεδομένων για να 

μπορείτε να επεξεργαστείτε. 

7.1.1 Γενικά 

Κατά τη δημιουργία της βάσης δεδομένων πρέπει να δώσετε ένα όνομα και 

μια περιγραφή για τη βάση. Μπορείτε επίσης να επιλέξετε αν θα εμφανίζεται η 

περιγραφή στη σελίδα του μαθήματος. 
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7.2 Εγγραφές 

Ρυθμίσεις τις οποίες μπορεί να κάνει ο χρήστης κατά τη δημιουργία της βάση 

δεδομένων. 

 Approval required – αν τεθεί “Yes”, οι καταχωρήσεις στη βάση θα είναι 

ορατές μόνο όταν ελεγχθούν από τον καθηγητή του course. 

 Allow comments in entries – αν τεθεί “Yes”, οι χρήστες θα μπορούν να 

εισάγουν σχόλια στις καταχωρήσεις της βάσης. 

 Entries required for completion – επιλέξτε πόσες καταχωρήσεις θέλετε να 

προσθέσει ο μαθητής για να θεωρηθεί η δραστηριότητα πλήρης. 

 Entries required before viewing – επιλέξτε πόσες καταχωρήσεις πρέπει να 

υποβάλλει ο μαθητής ώστε να μπορούν οι υπόλοιποι να τις δουν. 

Σημείωση: το database auto-link filter θα πρέπει να απενεργοποιηθεί αν 

απαιτείται να υπάρχουν καταχωρήσεις πριν την προβολή και αυτό 

συμβαίνει διότι δεν μπορεί να προσδιοριστεί αν ένας χρήστης έχει 

υποβάλλει τον απαιτούμενο αριθμό καταχωρήσεων. 

 Maximum number of entries – επιλέξτε το μέγιστο αριθμό καταχωρήσεων 

που δικαιούται ο κάθε μαθητής να υποβάλει για τη δραστηριότητα αυτή. 
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7.3 Availability 

Από “Available from/to” μπορείτε να επιλέξετε το χρονικό διάστημα κατά το 

οποίο η βάση δεδομένων θα είναι ορατή στους χρήστες. 

Από “Read only from/to” μπορείτε να καθορίσετε το χρονικό διάστημα κατά 

το οποίο οι χρήστες θα μπορούν να βλέπουν τα δεδομένα της βάσης αλλά δεν θα 

μπορούν να εισάγουν δεδομένα στη βάση. Για παράδειγμα θέτοντας τη βάση 

“Available” από 1η Ιανουαρίου ως 1η Μαρτίου αλλά “Read only” από 1η Ιανουαρίου 

ως 1η Φεβρουαρίου οι μαθητές θα μπορούν να δουν τις καταχωρήσεις στη βάση 

για ένα μήνα πριν να είναι σε θέση να προσθέσουν τις δικές τους. 

Η επιλογή “Available from/to” υπερισχύει της επιλογής “Read only from/to”. 

Για παράδειγμα αν έχετε θέσει για τη βάση σας “Read only” από 1η Ιανουαρίου και 

“Available from” από 1η Φεβρουαρίου οι μαθητές δεν θα είναι σε θέση να δουν τα 

περιεχόμενα της βάσης κατά τη διάρκεια του Ιανουαρίου. 

7.4 RSS 

Για να μπορείτε να χρησιμοποιήσετε το RSS feeds θα πρέπει ο 

administrator πρώτα να το ενεργοποιήσει για το Moodle site από Administration > 

Site administration > Advanced features > Enable RSS feeds. Έπειτα θα πρέπει 

να το ενεργοποιήσει και για τη βάση δεδομένων από Administration > Site 

administration > Plugins > Activity modules > Manage activities επιλέξτε Database 

settings. Τέλος στις ρυθμίσεις για τη βάση δεδομένων που δημιουργείται επιλέξτε 

τον αριθμό των καταχωρήσεων που θέλετε να εμφανίζεται στο RSS feeds. 

7.5 Grade 

Μπορείτε να επιλέξετε την κατηγορία για αυτή την δραστηριότητα στο 

gradebook. 
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7.6 Αξιολογήσεις 

Οι καταχωρήσεις σε μία βάση δεδομένων μπορούν να αξιολογηθούν εξ 

ορισμού από τους καθηγητές. Για να μπορούν και οι μαθητές να κάνουν 

αξιολογήσεις θα πρέπει να τους δοθούν τα κατάλληλα δικαιώματα από 

Administration > Database administration. Οι αξιολογήσεις αυτές καταγράφονται 

και στο gradebook. 

 

7.6.1 Δικαιώματα για αξιολογήσεις 

Οι καταχωρήσεις στη βάση δεδομένων μπορούν να αξιολογηθούν 

χρησιμοποιώντας μια κλίμακα. Εξ ορισμού μόνο οι καθηγητές μπορούν να 

αξιολογήσουν τις καταχωρήσεις. Αν θέλετε να μετέχουν στην αξιολόγηση και οι 

μαθητές θα πρέπει να τους δοθούν δικαιώματα από Administration > Database 

administration. Οι αξιολογήσεις καταγράφονται στο gradebook. 

7.6.2 Aggregate type 

Η ρύθμιση “Aggregated type” καθορίζει πως θα συνδυάζονται οι 

βαθμολογίες για να σχηματιστεί ο τελικός βαθμός του μαθητή στο gradebook. 

 Average of ratings – μέση τιμή όλων των αξιολογήσεων. 

 Count of ratings – το πλήθος των αξιολογήσεων γίνεται ο τελικός βαθμός. 

Σημείωση: το συνολικό ποσό δεν μπορεί να υπερβαίνει το μέγιστο βαθμό 

(maximum grade) για την δραστηριότητα. 

 Maximun – η υψηλότερη βαθμολογία. 

 Minimum – η χαμηλότερη βαθμολογία. 

 Sum – άθροισμα των αξιολογήσεων. Σημείωση: το συνολικό ποσό δεν 

μπορεί να υπερβαίνει το μέγιστο βαθμό (maximum grade) για την 

δραστηριότητα. 

Σημείωση: αν έχετε επιλέξει να μην υπάρχουν αξιολογήσεις για αυτή τη 

δραστηριότητα, οι αξιολογήσεις δεν θα εμφανίζονται στο gradebook. 
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7.6.3 Περιορισμός αξιολογήσεων 

Με τη ρύθμιση αυτή ο καθηγητής μπορεί να καθορίσει το χρονικό διάστημα 

μέσα στο οποίο οι μαθητές μπορούν να αξιολογήσουν τις δημοσιεύσεις. 

7.7 Common module settings 

7.7.1 Group mode 

Το group mode καθορίζεται σε επίπεδο course και είναι προεπιλεγμένη 

λειτουργία για τις δραστηριότητες ενός course. Κάθε δραστηριότητα μπορεί να έχει 

τα δικά της ξεχωριστά group. Ωστόσο αν το group mode έχει οριστεί σε επίπεδο 

course τότε τα ξεχωριστά group για κάθε δραστηριότητα θα αγνοούνται. Στο group 

mode έχετε τρεις επιλογές: 

 No groups – όλοι οι μαθητές συγκαταλέγονται σε ένα κοινό group. 

 Seperate groups – οι μαθητές διαχωρίζονται σε ξεχωριστά group και οι 

καθηγητές μπορούν να τους αξιολογούν είτε ανά group είτε όλους μαζί. 

 Visible groups – όλοι οι μαθητές μπορούν αν υποβάλλουν τις καταχωρήσεις 

τους σε ένα ενιαίο χώρο αλλά μπορούν να επιλέξουν ποιο group θα μπορεί 

να παρακολουθεί τις καταχωρήσεις τους. 

7.7.2 ID number 

Το ID number χρησιμοποιείται ως αναγνωριστικό για τον υπολογισμό 

βαθμού από τις αξιολογήσεις. Αν η δραστηριότητα δεν περιλαμβάνεται στις 

αξιολογήσεις τότε το πεδίο αυτό μπορεί να μείνει κενό. Το ID number μπορεί να 

καθοριστεί και στο gradebook. Επίσης μπορεί να χρησιμοποιηθεί και για 

διασύνδεση με εξωτερικά συστήματα. 

7.8 Restrict access/Activity completion 

Αυτή η επιλογή εμφανίζεται μόνο αν τα Conditional Activities και Activity 

Completion έχουν ενεργοποιηθεί στο Moodle site και για τα courses. 

7.9 Building Database 

Μετά τη δημιουργία της βάσης δεδομένων πρέπει να ορίσετε τα fields που 

καθορίζουν τις πληροφορίες για τη βάση δεδομένων. Προαιρετικά θα μπορούσατε 

να επεξεργαστείτε και τα templates για να καθορίσετε ή να αλλάξετε τον τρόπο 

εμφάνισης των δεδομένων. 

7.9.1 Database fields 

Κάθε εγγραφή – entry στη βάση μπορεί να έχει πολλαπλά fields 

πολλαπλών τύπων, όπως “date field” – επιτρέπει στο χρήστη να επιλέξει ημέρα, 

μήνα και έτος από τη dropdown list, picture field – επιτρέπει στο χρήστη να 

ανεβάζει στη βάση αρχείο εικόνας ή checkbox field – επιτρέπει στο χρήστη να 

επιλέγει μία ή περισσότερες ρυθμίσεις. Συνδυάζοντας τα διάφορα πεδία – fields με 
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τα κατάλληλα ονόματα και τους κατάλληλους τύπους θα πρέπει να είστε σε θέση 

να συλλέξετε τις πληροφορίες σχετικά με τη βάση δεδομένων. 

Σημείωση: για να επεξεργαστείτε τα πεδία - fields αργότερα θα πρέπει να 

χρησιμοποιήσετε το “Reset button” του template, ή να επεξεργαστείτε χειροκίνητα 

το template, για να εξασφαλίσετε ότι τα νέα fields έχουν προστεθεί. 

7.9.1.1 Field name and description 

Το όνομα του field θα πρέπει να είναι σύντομο και μοναδικό και η 

περιγραφή χρησιμεύει για το εντοπισμό του. 

7.9.1.2 Field types 

Παρακάτω αναλύονται οι τύποι των πεδίων παραθέτοντας και εικόνες για το 

«ΠΡΙΝ και «ΜΕΤΑ» από τις ρυθμίσεις. Οι εικόνες σε πορτοκαλί πλαίσιο δείχνουν 

τον τρόπο εμφάνισης των πεδίων στο χρήστη μετά από μία καταχώρηση. 

Checkbox 

Τοποθετήστε τις επιλογές για τα checkbox τη μία κάτω από την άλλη 

δίνοντας τη δυνατότητα στο χρήστη να επιλέξει ένα ή περισσότερα. 

 

Date 

Επιτρέπει στο χρήστη να εισάγει μια ημερομηνία επιλέγοντας το μήνα, τη 

μέρα και το έτος από drop down λίστα. 
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File 

Ο χρήστης μπορεί να κάνει upload αρχεία και αν αυτά είναι αρχεία εικόνας 

τότε το πεδίο της εικόνας αποτελεί την καλύτερη επιλογή. 

 

Latitude/longitude 

Οι χρήστες μπορούν να εισάγουν το γεωγραφικό πλάτος και μήκος (latitude 

& longitude) δημιουργώντας έτσι συνδέσμους με υπηρεσίες δεδομένων όπως 

Google Earth, OpenStreetMap, GeaBios, MapStars. Για παράδειγμα το Moodle 

HQ βρίσκεται στο -31,9545 και 115,877 γεωγραφικό πλάτος και μήκος αντίστοιχα. 

Ο καθηγητής μπορεί να επιλέξει ποιοι από αυτούς τους συνδέσμους θα 

εμφανίζονται, αν βέβαια υπάρχουν. 
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Menu 

Το κείμενο που εγγράφεται στη περιοχή “Options” εμφανίζεται ως μία drop 

down λίστα και ο χρήστης μπορεί να επιλέξει. Κάθε γραμμή αποτελεί και μία 

διαφορετική επιλογή. 

 

Menu(multi select) 

Το κείμενο που εισάγεται στην περιοχή “Options” εμφανίζεται ως μία λίστα 

που μπορεί να επιλέξει ο χρήστης. Κάθε γραμμή αποτελεί και μια διαφορετική 

επιλογή. Δίνεται η δυνατότητα κρατώντας πατημένο το “Ctrl” ή “Shift” ο χρήστης να 

έχει περισσότερες από μία επιλογές. 
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Number 

Ο χρήστης μπορεί να εισάγει αριθμούς. Υποστηρίζονται και οι αριθμοί 

κινητής υποδιαστολής (float). 

• 40 

• -1000 

• 0 

• 0.123 

• 3.0e8 
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Picture 

Ο χρήστης μπορεί να κάνει upload αρχείο εικόνας. Δίνοντας τιμές στα πεδία 

“Width in single view” και “Height in single view” η εικόνα θα εμφανίζεται από μόνη 

της σε αυτές τις διαστάσεις. Αντίστοιχα στα πεδία “Width in list view” και “Height in 

list view” η εικόνα θα εμφανίζεται, στις διαστάσεις που έδωσε ο χρήστης, μαζί με 

άλλες εικόνες. 
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Radio buttons 

Δίνεται η δυνατότητα στο χρήστη να επιλέξει ένα από τα radio buttons. Αν 

έχετε δύο επιλογές, αντίθετες συνήθως όπως True/False ή Yes/No, είναι 

προτιμότερο να χρησιμοποιήσετε checkboxes. 
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Text input 

Ο χρήστης μπορεί να εισάγει κείμενο μέχρι 60 χαρακτήρες. Για μεγαλύτερο 

κείμενο ή κείμενο που απαιτεί διαμόρφωση όπως κεφαλίδες ή κουκίδες μπορείτε 

να χρησιμοποιήσετε το “Text area field”. 

 

Text area 

Επιτρέπει στους χρήστες να επιλέξουν κείμενο μεγάλο σε μήκος 

χρησιμοποιώντας πρόγραμμα επεξεργασίας κειμένου. 
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URL 

Ο χρήστης μπορεί να εισάγει ένα σύνδεσμο για μια ιστοσελίδα. Αν επιλέξει 

ο χρήστης “Autolink the URL” τότε με ένα κλικ στο σύνδεσμο οδηγείται αυτόματα 

στην ιστοσελίδα. Αν στο πεδίο “Forced name for the link” εισάγετε ένα όνομα τότε 

ο σύνδεσμος θα εμφανίζεται με αυτό το όνομα. 
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7.9.2 Presets 

Για να αποφευχθεί η ανάγκη να δημιουργήσετε μία βάση δεδομένων από 

την αρχή μπορείτε να χρησιμοποιήσετε τα presets. Αυτά αποτελούν ένα image 

μιας βάσης ώστε να μπορέσετε να ξεκινήσετε. Μπορείτε να κάνετε τις δικές σας 

ρυθμίσεις καθώς και να τα μοιραστείτε με άλλους. 

7.9.2.1 Εισαγωγή preset 

Για να χρησιμοποιήσετε ένα preset: 

1. Στη σελίδα της βάσης δεδομένων πηγαίντε στην καρτέλα “Presets”. 

2. Για να εισάγετε ένα preset πατήστε “Choose file”και πατήστε “Import”. 

3. Εναλλακτικά επιλέξτε ένα υπάρχον preset. 

4. Μετά το “import” μπορείτε να προσθέσετε ή να εισάγετε και άλλες εγγραφές. 

Αφού πατήστε “Import” θα εμφανιστεί η επιλογή σε checkbox “Overwrite current 

settings”. Εάν το προσέξετε η βάση δεδομένων αντικαθιστά κάποιες από τις 

βασικές ρυθμίσεις όπως: 

• το “Introduction” HMTL κείμενο 

• “Required entries” 

• “Entries required before viewing” 

• “Maximum entries” 

• “Comments” 

• “Require approval?” 

• rssarticles 

7.9.2.2 Εξαγωγή preset 

Αν θέλετε να μοιραστείτε τα presets της βάσης σας με άλλους χρήστες, έχετε δύο 

επιλογές: 

1. να κάνετε “Export as ZIP”, και μπορείτε να το κάνετε “Import” σε άλλο course 

ή Moodle site. 

2. Να το αποθηκεύσετε ως “Preset”, και να δημοσιεύσετε τη βάση σας σε άλλους 

καθηγητές για να τη χρησιμοποιήσουν. Στη συνέχεια θα σας εμφανιστεί μία 

λίστα προεπιλογών (μπορείτε να τη διαγράψετε). 

Σημείωση: μόνο τα fields και τα templates αντιγράφονται κατά την εξαγωγή της 

βάσης δεδομένων ή μπορείτε να την αποθηκεύσετε ως preset. 

7.10 Database templates 

Τα templates στη βάση δεδομένων σας επιτρέπουν να ελέγχεται και να 

διαχειρίζεστε την αναπαράσταση των πληροφοριών της βάσης σας, τον τρόπο 

προβολής των καταχωρήσεων και την επεξεργασίας τους. Όλα τα templates στις 
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βάσεις δεδομένων του Moodle λειτουργούν με τις ίδιες αρχές. Βασικά αποτελούν 

HTML σελίδες με ετικέτες που ερμηνεύονται από το μηχανισμό των βάσεων 

δεδομένων του Moodle. 

Τα fields έχουν τη μορφή [[fieldname]] ενώ όλα οι υπόλοιπες ετικέτες έχουν 

τη μορφή ##sometag##. Παρακάτω παρουσιάζονται κάποιες ετικέτες: 

• ##edit## - δημιουργεί ένα εικονίδιο με σύνδεσμο που σας επιτρέπει να 

επεξεργαστείτε την τρέχουσα εγγραφή. (εμφανίζεται μόνο αν σας έχουν 

ανατεθεί τα κατάλληλα δικαιώματα ) 

• ##delete## - δημιουργεί ένα σύνδεσμο που σας επιτρέπει να διαγράψετε 

την τρέχουσα εγγραφή. (εμφανίζεται μόνο αν σας έχουν ανατεθεί τα 

κατάλληλα δικαιώματα ) 

• ##approve## - δημιουργεί ένα σύνδεσμο ώστε να μπορείτε να εγκρίνετε 

μία εγγραφή για τη βάση δεδομένων. (εμφανίζεται μόνο αν σας έχουν 

ανατεθεί τα κατάλληλα δικαιώματα ) 

• ##more## - σε single view δημιουργεί ένα σύνδεσμο που εμπεριέχει 

πληροφορίες 

• ##moreurl## - δημιουργεί το URL για τον παραπάνω σύνδεσμο. Μπορείτε 

να βάλετε το ##moreurl## στο εικονίδιο σύνδεσης ή στον HTML κώδικα να 

βάλετε: 

<a href="##moreurl##">[[fieldname]]</a>. 

• ##comments## - δημιουργεί ένα σύνδεσμο για να δείτε/επεξεργαστείτε τα 

σχόλια. (εμφανίζεται μόνο αν έχετε ενεργοποιήσει τα σχόλια) 

• ##user## - δημιουργεί ένα σύνδεσμο προς τη σελίδα του χρήστη που 

υπέβαλε την είσοδο. 

• ##timeadded## 

• ##timemodified## 

7.10.1 List template 

Το template αυτό αποτελεί την πρώτη σελίδα που εμφανίζεται στους 

φοιτητές όταν χρησιμοποιήσουν μία βάση δεδομένων στο Moodle. Δίνει μια γενική 

εικόνα των εγγραφών στη βάση και επιτρέπει στους χρήστες να το επεξεργαστούν. 

Κατά αρχήν θα πρέπει να επιλέξετε τα πιο χρήσιμα πεδία των εγγραφών που 

θέλετε να προβάλετε για τους χρήστες. Η εξ ορισμού απεικόνιση αυτού του 

template περιέχει πολλές πληροφορίες και το γεγονός δεν είναι και ότι καλύτερο 

για το χρήστη. Επίσης σας επιτρέπει να ελέγχεται τα fields που χρησιμοποιούνται 

καθώς, να ελέγχεται τη διάταξή τους κατά την προβολή πολλαπλών 

καταχωρήσεων ταυτόχρονα, για παράδειγμα αποτελέσματα αναζήτησης. 

Επιπλέον μπορεί να χρησιμοποιηθεί ως template για να κάνετε export τη βάση 

δεδομένων σε CSV αρχείο. 
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7.10.2 Single template 

Το template αυτό εμφανίζει μία καταχώρηση κάθε φορά και έτσι έχετε 

περισσότερο χώρο για να απεικονίσετε την πληροφορία στην οθόνη σας από ότι 

στο List template. 

 

7. 10.3 Advanced search template 

Το Advanced search template είναι κατάλληλο για τη δημιουργία μιας 

διεπαφής που χρησιμοποιείται σε advanced search. 

7. 10.4 Add template 

Από αυτή την επιλογή μπορείτε να προσθέσετε ένα template στη βάση 

δεδομένων σας ή να επεξεργαστείτε ένα ήδη υπάρχον. 

7. 10.5 RSS template 

Το template αυτό σας επιτρέπει να ελέγχεται το περιεχόμενο των RSS 

feeds για τις καταχωρήσεις σας στη βάση δεδομένων. 

7. 10.6 CSS template 

Μπορείτε με αυτό το template να διαχειριστείτε τα fonts, spacing, colors και 

τις υπόλοιπες ιδιότητές τους. 

7. 10.7 JavaScript template 

Το JavaScript template μπορεί να χρησιμοποιηθεί από άλλα templates. 

Σας επιτρέπει να προσθέσετε νέες συμπεριφορές στα άλλα templates ορίζοντας 

JavaScript ρουτίνες που μπορούν να φορτωθούν μαζί με τη σελίδα του εκάστοτε 

template. Μπορείτε να διαχειριστείτε τα στοιχεία στα List, Single και Add 

templates χρησιμοποιώντας τα JavaScript template. Για παράδειγμα έχετε ένα 

πεδίο στη βάση δεδομένων που αποθηκεύει το όνομα ενός ατόμου και όταν 

εμφανίζονται τα ονόματα στη List view θέλετε να μετράτε τις φορές που ένα όνομα 

ταιριάζει με κάποια κριτήρια. Η βάση δεδομένων θα περιέχει ένα field το οποίο θα 

ονομάζετε “name”. Στο List template θα εμφανιστούν τα περιεχόμενα αυτού του 
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πεδίου δημιουργώντας τη θέση όπου θέλετε να εμφανίζονται οι πληροφορίες. Για 

παράδειγμα στο Repeated entry θα έχετε: 

<table> <tr> <td>Name: [[name]]</td> </tr> <table> 

Θα πρέπει να τροποποιήσετε τα παραπάνω για να εξασφαλίσετε ότι το element - 

στοιχείο που θέλετε να διαχειριστείτε είναι το σωστό: 

<table> <tr> <td name="named">Name: [[name]]</td> </tr> <table> 

Το υποσέλιδο στο list view μπορεί να περιέχει ένα άλλο element - στοιχείο για να 

εμφανιστεί το αποτέλεσμα. 

<div name="result"></div> 

Ακολουθεί ένα παράδειγμα JavaScript template: 

var cnt = 0; 

var re = /foo|Foo/; 

function init(){ 

var namedElements = document.getElementsByName("named"); 

for (i=0; i < namedElements.length; i++) { 

if(re.test(namedElements[i].innerHTML)) cnt++; 

} 

var namedResult = document.getElementsByName("result"); 

namedResult[0].innerHTML = cnt; 

} 

window.onload = init; 

Ο παραπάνω κώδικας θα εμφανίσει ένα πίνακα ονομάτων και στο κάτω 

μέρος θα υπάρχει ο αριθμός των ονομάτων που ταιριάζουν με foo ή Foo. 

Σημειώστε ότι το window.onload() δεν χειρίζεται τυχόν εξαρτήσεις κώδικα YUI, 

οπότε ο κώδικάς σας θα λειτουργεί. Σε αυτή την περίπτωση αντί του onload, 

χρησιμοοιήστε: 

YUI().use (' node', 'other', 'dependencies', function(Y) { 

// Your code here. 

// This function is a closure so the Y object you define in the function 

definition is yours and nothing else on the page should be able to break it.}); 
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ΕΠΙΛΟΓΟΣ 

Σε μια βάση δεδομένων μπορούν να καταχωρηθούν αρχεία, κείμενα, 

εικόνες κ.ά. Ο χρήστης που δημιουργεί τη βάση μπορεί να κάνει τις βασικές 

ρυθμίσεις όσον αφορά τη χρήση της και τη λειτουργικότητά της. Μετά τη 

δημιουργία πρέπει να ορίσει τα πεδία που ορίζουν την πληροφορία στη βάση. Με 

τα template μπορεί να διαχειριστεί την αναπαράσταση των πληροφοριών της 

βάσης, τον τρόπο προβολής των καταχωρήσεων και την επεξεργασία τους.  
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ΚΕΦΑΛΑΙΟ 8 

Portal 
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ΕΙΣΑΓΩΓΗ 

Το κεφάλαιο αυτό αποτελεί την ολοκλήρωση της πτυχιακής εργασίας και 

παρουσιάζει τη δημιουργία του Portal με οδηγίες βήμα-προς-βήμα και εικόνες με 

τις ρυθμίσεις και επιλογές που γίνονται. Στην αρχή δημιουργείται ένα course και οι 

συμμετέχοντες διαχωρίζονται σε group. Έπειτα γίνεται δημιουργία “News forum” 

που χρησιμοποιείται στην κεντρική σελίδα του course και δημιουργία forum τύπου 

“Standard forum for general use”. Τέλος δημιουργείται και μία βάση δεδομένων για 

την καταχώρηση των εγγράφων. 

 

 

 

8.1 Δημιουργία course για το Portal 

Για να δημιουργήσετε ένα νέο course πηγαίνετε:  

 Administration > Site administration > Courses > Manage courses and 

categories. 

 Επιλέγετε ή δημιουργείτε, κατηγορία στην οποία θέλετε να εντάξετε το 

μάθημα. 

 Επιλέγετε “New course”. 

 

 

 
Εικόνα 1 - Δημιουργία course 
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Πατώντας “New course” εισάγεται το πλήρες όνομα του μαθήματος, 

επιλέγετε την κατηγορία στην οποία θέλετε να ανήκει το course, αν θα είναι ορατό 

ή όχι, την ημερομηνία έναρξης του course καθώς και το ID number (προαιρετικά) 

όπως στην παρακάτω εικόνα. 

 

 

 

 

 

 

 
 
Εικόνα 2 – Γενικές ρυθμίσεις για το course 

 

  

Έπειτα στην περιγραφή του course μπορείτε να γράψετε την περίληψη του 

μαθήματος καθώς και να κάνετε upload κάποια αρχεία που θα αφορούν την 

περίληψη – περιγραφή του course. 
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Εικόνα 3 - Περιγραφή του course 

 

  

 

Στη συνέχεια πρέπει να επιλέξετε τη μορφή του course (Course format). Οι 

επιλογές που έχετε είναι 4: 

 Weekly format 

 Social format 

 Topics format 

 Single activity format 

Σημείωση: αν επιλέξετε Weekly format και Topics format θα πρέπει να επιλέξετε 

και τον αριθμό των ενοτήτων στις οποίες θα οργανώνεται το course από την 

επιλογή “Number of sections”. Όπως επίσης και τα “Hidden sections” και “Course 

layout” που αναλύονται στο 4ο κεφάλαιο. 

 
Εικόνα 4 - Course format 
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Έπειτα μπορείτε να καθορίσετε τη γλώσσα την οποία θα χρησιμοποιούν οι 

χρήστες στο Moodle, να καθορίσετε τον αριθμό των πρόσφατων στοιχείων που θα 

εμφανίζονται στο “Latest news block”. Μπορείτε να αποφασίσετε αν θα εμφανίζεται 

στους μαθητές το Gradebook με τις αξιολογήσεις τους και τέλος μπορείτε να 

καθορίσετε αν οι συμμετέχοντες στο course θα μπορούν να δουν τα “Activity 

reports”.  

 

 
Εικόνα 5 – Appearance 

 

Η επόμενη επιλογή αφορά τα αρχεία που μπορείτε να ανεβάσετε στο 

course που έχετε δημιουργήσει, και πιο συγκεκριμένα μπορείτε να καθορίσετε το 

μέγιστο μέγεθος αρχείου. Στην παρακάτω επιλογή αν επιλέξετε “Yes” τότε στο 

course θα μπορούν να συμμετάσχουν και χρήστες με το ρόλο του επισκέπτη – 

Guest. Μπορείτε να δώσετε και κωδικό τον οποίο θα χρησιμοποιούν αυτοί οι 

χρήστες. 

 

 
Εικόνα 6 - File upload & Quest access 
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 Προχωρώντας παρακάτω έχετε τη δυνατότητα να επιλέξετε αν θα 

χρησιμοποιήσετε ομαδοποίηση – Groups ή όχι για το course. 

 

 
Εικόνα 7 – Groups 

 

Τέλος από την επιλογή “Role renaming” έχετε τη δυνατότητα να αλλάξετε 

ονομασίες για ρόλους. 

 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

113 από 132 

 
Εικόνα 8 - Role renaming 

 

 

  

Το συγκεκριμένο course έχει ονομασία Αλληλεπίδραση Ανθρώπου 

Μηχανής και Ανάπτυξη Διεπιδανειών Χρήστη. Έχει ως ημερομηνία έναρξης την 

20η Φεβρουαρίου και Course format: Weekly format. Μπορούν να συμμετάσχουν 

και χρήστες ως επισκέπτες δίνοντας κωδικό πρόσβασης 12345. Για να 

ολοκληρωθεί η δημουργία του course στο τέλος της σελίδας θα πρέπει να 

πατήσετε “Save changes”. Παρακάτω δίνεται η εικόνα του course μετά τη 

δημιουργία του στο Moodle site. 

 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

114 από 132 

 
Εικόνα 9 - Η σελίδα του course στο Moodle site 

 

8.2 Δημιουργία groups για το course 

 Σε αυτή τη παράγραφο θα δημιουργήσουμε groups για το παραπάνω 

course. Τα group που θα δημιουργηθούν θα είναι σε Course level και αυτό θα γίνει 

από: Administration > Course administration > Edit settings. 

 

 
Εικόνα 10 - Δημιουργία group 
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Για να δημιουργήσετε ένα group πατάτε “Create group”, δίνετε όνομα και ID 

number για το group, μπορείτε να δώσετε και περιγραφή, δίνετε Enrolment key αν 

το επιθυμείτε και τέλος μπορείτε να επιλέξετε και μια εικόνα για το group. Το 

συγκεκριμένο group θα έχει: 

 Όνομα: Τ1 

 ID number: 101 

 Enrolment key: Enrol_T1 

 

 
Εικόνα 11 – Επιλογές για δημιουργία group 

Στη συνέχεια πατάτε “Save changes” και στα δεξια πατάτε “Add/remove 

users” για να εγγράψετε, ή να διαγράψετε σε ήδη υπάρχον group, τους χρήστες. 

Επιλέγετε τους χρήστες, από τη λίστα “Potential members”, που θέλετε να 
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συμμετάσχουν στο group και πατάτε “Add”.

 
Εικόνα 12 - Επιλογή χρηστών για το group 

 

 

 

Η παρακάτω εικόνα δείχνει τη σελιδα με τα groups που έχουν δημιουργηθεί. 

Στα αριστερά της εικόνας διακρίνονται τα groups και στα αριστερά οι 

συμμετέχοντες στο επιλεγμένο group. 
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Εικόνα 13 - Λίστα με τα groups που έχουν δημιουργηθεί 

 

 

8.3 Δημιουργία forum για το course 

Η χρήση του forum αποτελεί μέρος του Portal και αναδυκνείεται παρακάτω. 

Στην αρχή παρατίθεται ένα News forum για τη σελίδα του course και ύστερα ένα 

forum για μια δραστηριότητα του course.  

Για τη δημιουργία του News forum πηγαίνετε στη σελίδα του course και από 

το Administration block ή επάνω και δεξιά στη σελίδα πατήστε “Turn editing on”. 

Στην κεντρική στήλη του homepage του course και επάνω πατήστε “Add an activity 

or resource” και από τη λίστα που εμφανίζεται επιλέξτε “Forum”. 
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Εικόνα 14 - Επιλογή News Forum 

 

  Για να δημουργηθεί το forum θα πρέπει να δώσετε όνομα και περιγραφή 

καθώς και να επιλέξετε έναν από τους 5 τύπους forum. Για αυτό το forum 

χρησιμοποιείται ο τύπος “Standrard forum for general use”. Στο τέλος της σελίδας 

πατάτε “Save and return to course” για να ολοκληρωθεί η διαδικασία και να 

επιστρέψετε στη σελίδα του course. 
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Εικόνα 15 - Επιλογές για τη δημιουργία του News forum 
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Εικόνα 16 - Η σελίδα του course μετά τη δημουργία του News forum 

 

Για κάθε δραστηριότητα σε ένα course μπορείτε να δημιουργήσετε ένα ή και 

περισσότερα forum. Όπως έχει αναφερθεί υπάρχουν 5 τύποι forum που μπορείτε 

να χρησιμοποιήσετε για μια δραστηριότητα. Παρακάτω φαίνεται η δημιουργία ενός 

Standard forum for general use και οι επιλογές που μπορείτε να καθορίσετε. 

Έχοντας επιλέξει την δραστηριότητα στην οποία θέλετε να προσθέσετε ένα forum, 

δίνετε όνομα, περιγραφή και επιλέγετε τον τύπο. Στην προκειμένη περίπτωση 

επιλέξαμε “Standard forum for general use”. 

 



Πτυχιακή εργασία του φοιτητή Πουλαρινού Ειρηναίου 

121 από 132 

 
Εικόνα 17 - Standard forum for general use 

 

Στην επιλογή “Attachments and word count” ο χρήστης μπορεί να καθορίσει 

το μέγεθος των αρχείων που μπορούν οι χρήστες να επισυνάπτουν στο forum, το 

πλήθος των αρχείων που μπορούν να επισυνάψουν και μπορούν να 

ενεργοποιήσουν την καταμέτρηση των λέξεων για τις δημοσιεύσεις. Όπως φαίνεται 

και στην εικόνα παρακάτω έχει επιλεγει ως μέγεθος αρχείου 64 MB, μέγιστος 

αριθμός για συννημένα 10 και η καταμέτρηση των λέξεων ενεργή. Αμέσως μετά 

ακολουθεί η επιλογή “Subscription and Tracking”. Στο “Subscription mode” έχει 

επιλεγεί “Forced subscription” που σημαίνει ότι οι συμμετέχοντες του course 

εγγράφονται αυτόματα στο forum και δε μπορούν να διαγραφούν από αυτό. Τέλος 

η επιλογή “Read tracking” έχει τεθεί “Optional”. 
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Εικόνα 18 - Attachments and subscription 

 

 Στην επόμενη επιλογή, “Post threshold for blocking”, έχει τεθεί η τιμή “1 

week” ως χρονικό διάστημα μπλοκαρίσματος ενός χρήστης κατά το οποίο θα 

ξεπεράσει συγκεκριμένο αριθμό δημοσιεύσεων, μέγιστος αριθμός δημοσιεύσεων 

με τιμή “10” και ο χρήστης μετά από 5 προειδοποιήσεις θα λαμβάνει ειδοποίηση 

για το ότι πλησιάζει το μέγιστο αριθμό δημοσιεύσεων.  

 

 
Εικόνα 19 - Post threshold for blocking 

 Ακολουθεί η επιλογή “Ratings”  η οποία χρησιμοποείται για τις αξιολογήσεις 

των μαθητών.  
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Εικόνα 20 – Αξιολογήσεις 

Στην τελευταία επιλογή “Common module settings” ο χρήστης μπορεί να 

επιλέξει αν θα είναι ορατός ή όχι κατά τη συμμετοχή του στο forum, μπορεί να 

καθορίσει ID number για τις διαδικασίες αξιολόγησης, να επιλέξει το Group mode ή 

και τα Groupings, αν αυτά έχουν δημιουργηθεί για τις ανάγκες διάφορων 

δραστηριοτήτων. Επειδή το συγκεκριμένο forum χρησιμοποιείται για γενικές 

συζητήσεις στο course, η επιλογή “Group mode” έχει τεθεί “No groups”. 

 

 
Εικόνα 21 - Common module settings 
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 Με τον καθορισμό όλων των επιλογών στο τέλος της σελίδας πατήστε 

“Save and return to course” για να αποθηκεύσετε τις επιλογές σας και να 

επιστρέψετε στη σελίδα του course. 

 

8.4 Δημιουργία βάσης δεδομένων για το course 

 Μεταξύ άλλων το portal απαιτεί μία βάση δεδομένων για την καταγραφή 

εγγράφων διαφόρων τύπων και την καταγραφή τους σε αυτή. Για τη δημιουργία 

της βάσης δεδομένων είτε από το Administration block είτε από επάνω και δεξιά 

στην σελίδα του course πατήστε “Turn editing on”. Πατήστε “Add an activity or 

resourse” και από τη λίστα που εμφανίζεται επιλέξτε “Database” και πατήστε 

“Add”. Δώστε ένα όνομα και περιγραφή της βάσης δεδονένων.  

 

 
Εικόνα 22 - Ονομασία και περιγραφή της βάσης δεδομένων 

 

Στην επιλογή “Entries”  θέστε το “Approval required” σε “Yes” ώστε τα 

έγγραφα που κάνουν upload οι χρήστες να ελέγχονται από τον καθηγητή, στο 

“Allow comments to entries” θέστε “Yes” ώστε να επιτρέπεται στους χρήτες να 

εισάγουν σχόλια στις καταχωρήσεις τους. 
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Εικόνα 23 - Εγγραφές της βάσης δεδομένων 

 Στην επόμενη επιλογή μπορείτε να καθορίσετε τα χρονικά διαστήματα κατά 

τα οποία η βάση δεδομένων θα είναι διαθέσιμη στους χρήστες της και τα χρονικά 

διαστήματα κατά τα οποία οι χρήστες θα μπορούν να δουν τα δεδομένα της βάσης 

αλλά δεν θα μπορούν να καταχωρήσουν δεδομένα στη βάση. 

 

 
Εικόνα 24 - Διαθεσιμότητα της βάσης δεδομένων 

 

 

 

 

 

 

 

  Στην τελευταία επιλογή “Common module settings” επιλέγετε αν θα είναι 

ορατή η βάση, το ID number, Group mode και Groupings. 
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Εικόνα 25 - Common module settings 

Για να ολοκληρώσετε τη δημιουργία της βάσης δεδομένων στο τέλος της 

σελίδας πατήστε “Save and return to course”  για να αποθηκευτούν οι αλλαγές και 

να επιστρέψετε στη σελίδα του course. 

Καθώς βρίσκεστε στη σελίδα του course πατήστε στο σύνδεσμο της βάσης 

δεδομένων για να εισέλθετε στη βάση όπως φαίνεται παρακάτω. 

 

 
Εικόνα 26 - Σελίδα βάσης δεδομένων 
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Για να δημιουργήσετε ένα πεδίο για τη βάση στην καρτέλα “Fields” από τη 

drop-down list του Create a new field επιλέξτε “File”. 

 

 
Εικόνα 27 - Δημιυργία πεδίου 

Δώστε ένα όνομα για το πεδίο που δημιουργείτε, μία περιγραφή και επιλέξτε 

το μέγιστο μέγεθος για τα αρχεία που θα ανεβάζουν οι χρήστες. Σε αυτό το σημείο 

έχει δημιουργηθεί ένα πεδίο για τη βάση δεδομένων. Πηγαίνετε στη καρτέλα “Add 

entry” για να εισάγετε μία εγγραφή στη βάση. 

 

 
Εικόνα 28 - Εισαγωγή εγγραφής στη βάση δεδομένων 
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Από την καρτέλα “Templates”  επιλέξτε το template που θέλετε να 

χρησιμοποείται από τη βάση για την αναπαράσταση των δεδομένων της.  

 

 
Εικόνα 29 - Επιλογή template 

Παρακάτω η εικόνα δείχνει ένα παράδειγμα μιας βάσης δεδομένων με 

καταχωρημένα αρχεία. 
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Εικόνα 30 - Βάση δεδομένων με καταχωρημένα αρχεία 
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ΕΠΙΛΟΓΟΣ 

   Για την ολοκλήρωση της πτυχιακής κρίθηκε αναγκαίο να γίνει μια επίδειξη 

για το πώς δημιουργήθηκαν τα βασικά στοιχεία του Portal. Αυτό επιτυγχάνεται 

δίνοντας αναλυτικές οδηγίες και αυτές αναπαριστώνται με εικόνες ώστε η 

διαδικασία να γίνεται πιο απλή και κατανοητή στο χρήστη. Αρχικά δημιουργήθηκε 

ένα course τύπου weekly format. Δημιουργήθηκαν group για τον διαχωρισμό των 

συμμετεχόντων σε ομάδες. Στη συνέχεια δημιουργήθηκαν 2 forum, ένα για την 

κύρια σελίδα του course το οποίο αποτελεί το forum γενικού σκοπού, και ένα forum 

τύπου “Standard forum for general use” για μια δραστηριότητα του course. Τέλος 

παρουσιάζεται και η δημιουργία μιας βάσης δεδομένων, καθώς και των πεδίων και 

των εγγραφών αυτής, για την καταχώρηση των εγγράφων σε αυτή.   
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ΣΥΜΠΕΡΑΣΜΑΤΑ 

Κατά τη διαδικασία της έρευνας και μελέτης για την ανάπτυξη αυτής της 

πτυχιακής εργασίας διαπίστωσα ότι το Moodle είναι μία πλατφόρμα με την οποία 

οποιοσδήποτε χρήστης μπορεί να δημιουργήσει ένα δικό του περιβάλλον για 

σύγχρονη εκπαίδευση. Aποτελεί μία web-based πλατφόρμα που σημαίνει ότι οι 

χρήστες μπορούν να έχουν πρόσβαση στο site που θα δημιουργήσουν 

οποτεδήποτε και από οπουδήποτε. Παρέχει cross-browser compatibility, οπότε 

είναι προσπελάσιμο από οποιοδήποτε browser. Επίσης είναι και mobilecompatible, 

οπότε παρέχει και πρόσβαση από φορητές συσκευές όπως κινητά τηλέφωνα, 

tablets κ.ά. Στην πορεία της ανάπτυξης της εργασίας εξοικειώθηκα με τεχνολογίες 

που απαιτούνται για την εγκατάσταση και τη λειτουργία της πλατφόρμας. Η 

κοινότητα του Moodle παρέχει documentation και έτσι μπόρεσα να μελετήσω με 

μεγαλύτερη ακρίβεια τις απαιτήσεις για τη δημιουργία του portal και έπειτα να τις 

εφαρμόσω. Οι λειτουργίες και οι εφαρμογές που προσφέρει η πλατφόρμα αυτή 

είναι τόσες πολλές που θα μπορουσε να γραφτεί και βιβλίο. Το Moodle μου έδωσε 

τη δυνατότητα να κατασκευάσω αυτό το portal και όλες τις απαιτούμενες 

λειτουργίες με πολύ απλό και εύκολο τρόπο. Με το τέλος της πτυχιακής μου 

συνειδητοποίησα την πληθώρα επιλογών που προσφέρει για την εφαρμογή της 

ηλεκτρονικής μάθησης.  
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